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All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use 
with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third 
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, 
or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the 
U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options 
or any consumable products other than those designated as Original EPSON Products or EPSON Approved 
Products by SEIKO EPSON CORPORATION.

EPSON, EPSON ESC/P, and EPSON Stylus are registered trademarks and EPSON ESC/P 2 is a trademark of SEIKO 
EPSON CORPORATION. EPSON SoundAdvice is a service mark and EPSON FaxAdvice, and PhotoEnhance are 
trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Copyright © 1998 by Epson America, Inc. CPD-7449
10/98
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FCC Compliance Statement
For United States Users

This printer has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference 
in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio or television 
reception. However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause interference to radio and television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of the following 
measures.

◗ Reorient or relocate the receiving antenna. 

◗ Increase the separation between the equipment and receiver.

◗ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

◗ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC 
Certification of this device and may cause interference levels which exceed the limits established by the FCC for 
this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this 
device. If this equipment has more than one interface connector, do not leave cables connected to unused 
interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to 
operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le materiel brouilleur du 
Canada.

bunnyUG.book  Page iii  Wednesday, November 4, 1998  9:22 AM



iv

bunnyUG.book  Page iv  Wednesday, November 4, 1998  9:22 AM



v

Contents

Introduction
Windows System Requirements  1
Macintosh System Requirements 2
How To Use Your Manuals  3

Warnings, Cautions, Notes, and Tips 4
Where To Get Help 5
ENERGY STAR Compliance  6
Year 2000 Ready 6
Important Safety Instructions  7

1 Basic Printing
Printing from Windows 1-1

Setting Printer Options from Windows Applications 1-2
Setting Default Printer Options 1-4
Checking Printer Status 1-5

Printing from a Macintosh 1-7
What To Do When the Printer Lights Flash 1-10

bunnyUG.book  Page v  Wednesday, November 4, 1998  9:22 AM



Contents

vi

2 Printing on Special Paper
Using Special Paper and Media 2-1

Letterhead, Preprinted Forms, and Legal-size Paper 2-3
EPSON 360 dpi, High Quality, and Photo Quality 

Ink Jet Paper 2-3
EPSON Photo Quality Glossy Paper, Film, and 

Transparencies 2-4
Envelopes 2-5
EPSON Photo Paper 2-6
EPSON Photo Quality Ink Jet Cards 2-7
EPSON Photo Quality Self Adhesive Sheets 2-8
EPSON Iron-On Transfer Paper 2-8

3 Custom Printing
Using Predefined Advanced Settings 3-2
Customizing Print Quality and Special Effects 3-4
Customizing Color Settings 3-7
Using ColorSync on the Macintosh 3-9
Selecting Paper Size and Orientation Options 3-11

Selecting Paper Options in Windows 3-11
Selecting Paper Options on a Macintosh 3-15

Selecting Print Layout Options 3-20
Choosing Print Layout Options in Windows 3-20
Choosing Print Layout Options on a Macintosh 3-27

Saving Custom Settings 3-33
Redefining Custom Settings 3-34
Deleting Custom Settings 3-34

bunnyUG.book  Page vi  Wednesday, November 4, 1998  9:22 AM



Contents

vii

4 Managing Print Jobs
Managing Print Jobs in Windows 98, Windows 95, 

and Windows NT 4.0 4-1
Using Status Monitor 2 4-2
Selecting the Speed & Progress Options (Windows 98 and 

Windows 95) 4-9
Using the Spool Manager (Windows 98 and 

Windows 95) 4-11
Additional Monitoring Options in Windows NT 4.0 4-12

Managing Print Jobs in Windows 3.1 4-13
Using the Spool Manager 4-13

Managing Print Jobs on a Macintosh 4-15
Using Monitor3 4-16
Using the Macintosh Status Monitor 4-17
Selecting Configuration Options 4-19

5 Maintenance and 
Transportation

Replacing an Ink Cartridge  5-1
Removing an Empty Ink Cartridge 5-2
Installing the New Cartridge 5-4
Replacing an Outdated Ink Cartridge 5-5

Cleaning the Print Heads  5-6
Using the Head Cleaning Utility 5-6
Using the Control Panel 5-7
Examining the Nozzle Check Pattern 5-8

Aligning the Print Heads  5-8
Using the Print Head Alignment Utility 5-9
Using the Control Panel 5-9

Cleaning the Printer  5-10
Transporting the Printer  5-10

bunnyUG.book  Page vii  Wednesday, November 4, 1998  9:22 AM



Contents

viii

6 Troubleshooting
Diagnosing Problems  6-1

Checking the Control Panel Lights 6-2
Running a Self Test 6-3
Using Hex Dump Mode 6-4

Improving Print Quality  6-4
Solving Printing Problems  6-8
Solving Printer Software Problems 6-10
Fixing Paper Problems  6-13
Solving Miscellaneous Printout Problems 6-15
Uninstalling Printer Software 6-17

A EPSON Accessories

B Technical Specifications

Glossary

Index

bunnyUG.book  Page viii  Wednesday, November 4, 1998  9:22 AM



1

Your EPSON Stylus® COLOR 850Ne bundled printer/print 
server is the ideal shared output device for business graphics, 
layout proofs, digital photography, or any project created by 
users on your network. With resolutions up to 1440 by 720 
dpi, you get amazingly realistic photographic images and vivid 
graphics in color, or razor-sharp black printing. All at the fastest 
speed of any EPSON ink jet printer.

The printer software for Microsoft® Windows® and 
Macintosh® provides advanced color management with 
adjustable levels of brightness, contrast, saturation, and ink 
colors. Support for ColorSync™ 2.01 and Windows ICM 
ensures printouts that closely match the colors on your monitor.

Your printer offers flexible resource sharing; you can use it with 
multiple types of operating systems and network operating 
systems. With an integrated Ethernet card for complete 
network connectivity, setup is fast and easy. 

Windows System Requirements 
To use your printer and its software with a PC, your system 
should have:

◗ An IBM® compatible PC with at least a 386/25 MHz (for 
Windows 3.1) or 486/25 (for Windows 98, Windows 95 or 
Windows NT 4.0) or faster processor

◗ DOS, Microsoft Windows 3.1x, Windows 95, 
Windows 98, or Windows NT 4.0

◗ At least 16MB of RAM (20MB recommended)

Introduction

Note:
Your EPSON Stylus 
COLOR 850Ne printer is 
identical to the EPSON 
Stylus COLOR 850 except 
for the added network 
capabilities. Therefore, this 
guide refers to the EPSON 
Stylus COLOR 850 printer 
driver software.
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◗ At least 50MB of free hard disk space for storing images 
(100MB or more is recommended)

◗ VGA, Super VGA, or better display adapter and monitor

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software

◗ Network connection to Ethernet

◗ A twisted-pair (10BaseT) cable to connect the printer’s 
Ethernet card to your network

Macintosh System Requirements
To use your printer and its software with a Macintosh, your 
system should have:

◗ Any Macintosh or Power Macintosh model except the 
Macintosh +, Macintosh 512, Performa® 410, 
PowerBook® 100, and some early versions of the 
Macintosh, such as the II or Classic 

◗ System 7.1 or later (7.5 or later recommended)

◗ At least 16MB of RAM (20MB or more is recommended)

◗ At least 50MB of free hard disk space for storing images 
(100MB or more is recommended)

◗ 13-inch RGB display or better

◗ Double-speed CD-ROM drive (quad-speed or faster 
recommended) for installing the printer software

◗ Network connection to Ethernet

◗ A twisted-pair (10BaseT) cable to connect the printer’s 
Ethernet card to your network
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How To Use Your Manuals 
See the Setup Guide to set up your printer, install your software, 
and configure the card for the network. See the Administrator’s 
Guide for network, configuration, and Ethernet card 
information. This User’s Guide contains the following 
information:

Chapter 1 covers the basics of printing with Windows or 
Macintosh.

Chapter 2 gives guidelines for selecting the right paper or other 
media for your print job and instructions for loading it in your 
printer.

Chapter 3 tells you how to print special projects with custom 
settings for print quality, color management, and distinctive 
layouts.

Chapter 4 explains how to manage print jobs and check printer 
status while you’re printing.

Chapter 5 gives instructions for replacing ink cartridges, 
cleaning and aligning the print heads, and cleaning and 
transporting the printer.

Chapter 6 provides solutions for problems you may have. (For 
solutions to network problems, see Chapter 7 in your 
Administrator’s Guide.)

Appendix A lists the EPSON accessories you can use with your 
printer.

Appendix B provides technical details on your printer, ink 
cartridges, and media.

A Glossary and Index are included at the end of the book.
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Warnings, Cautions, Notes, and Tips

You’ll find this information throughout your manual:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information about your printer.

Tips contain additional hints for great printing.
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Where To Get Help
EPSON provides technical assistance through electronic 
support services and automated telephone services 24 hours a 
day. The following tables list the contact information:

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com.

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser (or 
other software for FTP downloading) to log onto ftp.epson.com 
with the user name anonymous and your e-mail address as the 
password.

EPSON Download Service You can call the EPSON Download Service at (800) 442-2007. Set 
your communications software to 8 data bits, 1 stop bit, no parity. 
Modem speed can be up to 28.8 Kbps.

EPSON Forum on 
CompuServe® 

Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 and 
ask for representative #529.

Automated telephone services

Service Access

EPSON SoundAdviceSM For pre-recorded answers to commonly asked questions about 
EPSON products 24 hours a day, seven days a week, call 
(800) 922-8911.

EPSON FaxAdvice™ Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to use 
this service.

EPSON Referral Service For the location of your nearest Authorized EPSON Reseller or 
Customer Care Center, call (800) 922-8911.
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To speak to a technical support representative, dial 
(310) 787-6346 (U.S.) 6 AM to 8 PM Pacific Time, Monday 
through Friday and 7 AM to 4 PM, Saturday, or (905) 709-2567 
(Canada), 6 AM to 6 PM, Pacific Time, Monday through Friday. 
Toll or long distance charges may apply.

Before you call, please have the following information ready:

◗ Product name

◗ Product serial number

◗ Computer configuration

◗ Description of the problem

You can purchase ink cartridges, paper, manuals, and 
accessories from EPSON Accessories at (800) 873-7766 (U.S. 
sales only). In Canada, please call (800) 873-7766, for dealer 
referral. Or visit our website at www.epsonsupplies.com (U.S. 
sales only).

ENERGY STAR Compliance 
As an ENERGY STAR Partner, EPSON has determined that 
this product meets the ENERGY STAR guidelines for energy 
efficiency. 

The EPA ENERGY STAR Office Equipment program is a 
voluntary partnership with the computer and office equipment 
industry to promote the introduction of energy-efficient 
personal computers, monitors, printers, fax machines, and 
copiers in an effort to reduce air pollution caused by power 
generation. 

Year 2000 Ready
Your EPSON Stylus COLOR 850Ne is Year 2000 Ready. 
However, be sure the other parts of your computer system are 
also ready for the year 2000.

Note:
If you need help using 
another manufacturer’s 
software with an EPSON 
product, see the 
documentation for that 
program for technical 
support information.
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Important Safety Instructions
Before using your printer, read the following safety instructions 
to make sure you use the printer safely and effectively:

◗ Turn off and unplug the printer before cleaning. Clean 
with a damp cloth only. Do not spill liquid on the printer.

◗ Do not place the printer on an unstable surface or near a 
radiator or heating vent.

◗ Do not block or cover the openings in the printer’s cabinet 
or insert objects through the slots.

◗ Use only the type of power source indicated on the printer’s 
label.

◗ Connect all equipment to properly grounded power 
outlets. Avoid using outlets on the same circuit as 
photocopiers or air control systems that regularly switch 
on and off.

◗ Place the printer near a wall outlet where the plug can be 
easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche 
peut être débranchée facilement.

◗ Do not let the power cord become damaged or frayed.

◗ If you use an extension cord with the printer, make sure 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord’s ampere rating. 
Also, make sure the total ampere rating of all devices 
plugged into the wall outlet does not exceed the wall 
outlet’s ampere rating.

◗ Except as specifically explained in this User’s Guide, do not 
attempt to service the printer yourself.

Caution:
Always turn the printer 
off using the 

 

Ppower 
button. If you’re using a 
power strip, do not 
switch it off or unplug the 
printer until the 

 

Ppower 
light is off.
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◗ Unplug the printer and refer servicing to qualified service 
personnel under the following conditions: 

If the power cord or plug is damaged; if liquid has entered 
the printer; if the printer has been dropped or the cabinet 
damaged; if the printer does not operate normally or 
exhibits a distinct change in performance. Adjust only those 
controls that are covered by the operating instructions.

◗ Do not put your hand inside the printer or touch the 
cartridge during printing.

◗ Under normal circumstances, ink will not come out of the 
cartridge. If it does get on your skin, wash it off with soap 
and water. If it gets in your eyes, flush them immediately 
with water.

◗ Keep ink cartridges out of the reach of children.

◗ Do not dismantle the ink cartridges or try to refill them. 
This could result in damage to the print head.

◗ Once you install an ink cartridge, do not open the clamp or 
remove the cartridge except to replace it with a new one. 
The cartridge may become unusable otherwise.

◗ Install the ink cartridge immediately after you remove it 
from its foil package. Leaving the cartridge unpacked for a 
long time before use may result in reduced print quality.

◗ Do not use an ink cartridge beyond the date printed on the 
cartridge carton. For best results, use up the ink cartridges 
within six months of installing them.

◗ Do not shake an ink cartridge; this can cause leakage.

◗ Always turn the printer off using the 

 

Ppower button. 
When you press this button, the 

 

Ppower light flashes 
briefly then goes out. Do not unplug the printer or turn off 
the power to the outlet until the 

 

Ppower light is off.

◗ Before transporting the printer, make sure the print head is 
capped in the far right position and the ink cartridges are in 
place.
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It’s easy to print all your color and black-and-white documents 
with your EPSON Stylus COLOR 850Ne. First set up your 
printer, install the software, and configure the card on the 
network, following the instructions in the Setup Guide. Then 
read this chapter to find out about:

◗ Printing from Windows

◗ Printing from a Macintosh

◗ What to do when the printer lights flash

Printing from Windows
To print from a Windows application, you choose Print from 
the File menu. You can then choose which pages to print, the 
number of copies, and other options from your application’s 
Print dialog box.

When you click a button in the Print dialog box, you select 
additional settings using your printer software, such as the 
media type you’ve loaded and the resolution you want to use. 

The following sections tell you how to do the following:

◗ Select printer software settings and print from Windows 
applications

◗ Change the default printer software settings

◗ Check your printer’s status while you print

Basic Printing

Note:
Setup instructions for 
NetWare using 
PCONSOLE, OS/2, and 
UNIX are in the 
Administrator’s Guide. 
Appendix B has DOS 
support information.
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Setting Printer Options from Windows 
Applications

This section describes the settings you’ll need to check for all 
your everyday printouts. See Chapter 3 for information about 
advanced settings for special print jobs. 

1. Open your word processor or other Windows software 
application and open a file you want to print.

2. Choose Print from the File menu. You see the Print dialog 
box for your application.

3. Make sure your EPSON Stylus COLOR 850 printer is 
selected, and then click the Printer, Setup, Properties, or 
Options button. (You may have to click a sequence of 
buttons in different dialog boxes.) 

You see the printer settings dialog box:

4. Click the Main tab if necessary and make sure the Mode 
option is set to Automatic. This is the easiest way to get 
good printing results for all kinds of documents, on all 
types of paper.

Note:
You can also set printer 
options by clicking Print 
Setup in the File menu, 
then clicking the Printer, 
Setup, Properties, or 
Options button. 
However, in most 
applications you’ll then 
have to select the Print 
option from the File 
menu to print using your 
changes.

Click to 
select your 
media type

Click for 
more 
information

Use the Quality/Speed slider to select 
your print resolution

Click to 
select 
Automatic 
mode

For more information 
about printer settings, 
click the Help button. 
In Windows 98, 
Windows 95, and 
Windows NT, you can 
right-click any item on 
the screen and then click 
What’s This?
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5. Choose the Media Type you want to print on from the 
following list:

◗ Plain paper

◗ 360 dpi Ink Jet Paper

◗ Photo Quality Ink Jet Paper

◗ Photo Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of paper or other media you choose determines 
the print quality (resolution) you can use. If you’re not sure 
which setting to select for your media, see the table on 
page 2-1.

6. Choose Color or Black ink.

7. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or highest resolution for the 
media you’re using. 

To use the highest resolution available for plain paper 
(1440 dpi), access the More Settings dialog box. (Click 
Advanced, then click More Settings.)

8. Click the Paper tab and choose your paper size, number of 
copies, orientation, and printable area. 

9. Click the Layout tab (not available in Windows 3.1x) and 
check the proportional printing, page layout, and 
watermark options to make sure they’re correct for your 
print job.

10. Click OK when you’re finished checking your settings. 

11. In the Print dialog box, click OK or Print. You may need to 
click a sequence of these buttons on different dialog boxes. 

To print at the highest 
resolution (1440 dpi), you 
can use plain paper, Photo 
Paper, or one of the Photo 
Quality media. For the 
best printing at any 
resolution, always use 
EPSON media.

The Quality/Speed slider is 
not available for certain 
media types.

Note:
See Chapter 3 for detailed 
instructions on using printer, 
layout, and paper settings.

If you installed Status Monitor 
2, you may want to click the 
Utility tab and open the 
Printer Status window. See 
Chapter 4 for information on 
Status Monitor 2; see 
Chapter 5 for instructions on 
using the other utilities on the 
Utility tab.
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While your document is printing, a dialog box appears 
showing the printer status and the progress of your print 
job. See “Checking Printer Status” on page 1-5 for more 
information.

Setting Default Printer Options

When you change printer settings through your software 
application, the settings apply only to the application you’re 
using. To adjust the default settings for all your Windows 
applications, access the settings through the Windows 98, 
Windows 95, or Windows NT 4.0 Printers utility or the 
Windows 3.1 Control Panel. (Close all your applications before 
you start. If you don’t, you may have to close and reopen them 
to use the new default settings.)

Setting Default Options in Windows 98 and 
Windows 95

1. Click Start, point to Settings, and select Printers. 

2. Right-click the EPSON Stylus COLOR 850 icon. 

3. Select Properties. You see the printer software dialog box, 
as shown on page 1-2. 

Setting Default Options in Windows NT 4.0

1. Click Start, point to Settings, and select Printers.

2. Double-click the EPSON Stylus COLOR 850 icon.

3. Open the File menu and select Document Defaults. You 
see the printer software dialog box, as shown on page 1-2. 

Note:
Some application settings 
override driver settings 
(such as Paper Size or 
Orientation), so it’s a 
good idea to check the 
settings in your 
application before you 
print. See page 1-2 for 
instructions.

Note:
You can access the 
default Windows NT 
printer software settings 
only if you have the 
appropriate network 
access privileges, such 
as Administrator or 
Power User.
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Setting Default Options in Windows 3.1 

1. Double-click the Control Panel icon in the Main group. 

2. Double-click the Printers icon. 

3. Select EPSON Stylus COLOR 850 from the list of printers 
and click Setup. You see the printer software dialog box, as 
shown on page 1-2. 

Checking Printer Status

While your document is printing, your printer software reports 
how the job is doing. See the section for your operating system 
below.

Windows 98 and Windows 95

After you send a print job in Windows 98 or Windows 95, the 
Progress Meter dialog box appears on your screen:

The Progress Meter shows the progress of your print job and 
the status of your printer. You can use the buttons to cancel, 
pause, or restart your print job. If you installed Status 
Monitor 2, you also see information about how much ink you 
have left and can view the Status Monitor 2 Printer Status 
window. See page 4-2 for more information about Status 
Monitor 2.

Click to pause 

Click to cancel 

Click to restart 

Click to view 
the Status 
Monitor 2 
Printer Status 
window

This 
information 
appears only 
if you 
installed 
Status 
Monitor 2 
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You can set up the way your printer software sends print jobs 
and select whether to display the Progress Meter dialog box or 
not; see page 4-9 for instructions.

Windows NT 4.0

If you installed Status Monitor 2, you see information about 
how much ink you have left and can view the Status Monitor 2 
Printer Status window. See page 4-2 for more information. 
Windows NT 4.0 servers and workstations also include a 
messenger service to alert you to printer errors or let you know 
when a print job is finished. If you have appropriate network 
access privileges or you’re controlling printing from the server, 
you can also cancel, pause, or restart print jobs and set other 
options. See your Windows NT documentation for details.

Windows 3.1 

After you send your print job, the EPSON Despooler dialog 
box appears on your screen:

This dialog box shows the progress of your print job and the 
status of your printer. If you run out of paper while printing, for 
example, the Despooler warns you. You can use the buttons to 
cancel, pause, or restart your print job.

Click to pause 
or resume 
printing

Click to 
cancel printing

Click to restart 
printing
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Printing from a Macintosh
When you print with a Macintosh, you need to check the 
printer software settings for documents in each application you 
use. When you choose Page Setup or Print from the File 
menu, you see the printer software dialog boxes that let you 
choose the settings that describe your print job—such as the 
media type you’ve loaded and the resolution you want to use. 

This section describes the settings you’ll need to check for all 
your everyday printouts. See Chapter 3 for information about 
advanced settings for special print jobs. 

Follow these steps to print from a Macintosh:

1. Open your word processor or other Macintosh software 
application and open a file you want to print.

2. Choose Page Setup from the File menu. You see the Page 
Setup dialog box:

3. Choose your paper size, orientation, and other options as 
described on page 3-15 and click OK. 

Note:
On the Macintosh, printer 
settings are saved with 
your document, but you 
can’t save them from one 
application to another. 
You’ll have to check your 
settings each time you 
open a new application. If 
you want to reuse 
settings, you can create 
document templates for 
your favorite applications.

You can also create 
custom setting groups in 
your printer software that 
you can select each time 
you open an application. 
See page 3-33 for details.
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4. Now select Print from the File menu in your application. 
You see the printer settings dialog box:

5. Choose the number of copies and indicate which pages you 
want to print.

6. Make sure the Mode option is set to Automatic. This is 
the easiest way to get good printing results for all kinds of 
documents, on all types of paper.

7. Choose the Media Type you want to print on from the 
following list:

◗ Plain Paper

◗ 360 dpi Ink Jet Paper 

◗ Photo Quality Ink Jet Paper

◗ Photo Paper

◗ Photo Quality Glossy Film

◗ Ink Jet Transparencies

The type of paper or other media you choose determines 
the print quality or resolution you can use. If you’re not 
sure which setting to select for your media, see the table on 
page 2-1.

8. Choose Color or Black ink.

Click to select your media type

Use the Quality/Speed 
slider to select your 
print resolution

Click to 
select 
Automatic 
mode

For printing at the highest 
resolution (1440 dpi), you 
need to use plain paper, 
Photo Paper, or one of the 
Photo Quality media. For 
the best printing at any 
resolution, always use 
EPSON media.
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9. Set the slider to Quality or Speed. This lets you choose 
between the fastest printing or the highest resolution for the 
media you’re using. To use the highest resolution available 
for plain paper (1440 dpi), access the More Settings dialog 
box; see page 3-4 for instructions.

10. Click the Layout button and check the proportional 
printing, watermark, and page layout options to make sure 
they’re correct for your print job. Then click OK to return 
to the printer settings dialog box.

11. Click Print when you’re finished checking your settings. 

If you chose background printing when you set up your 
printer, you can continue working while your document is 
printing. See “Using Monitor3” on page 4-16.

Note:
The Quality/Speed slider 
is not available for certain 
media types.

For detailed instructions 
on using page layout 
options, see Chapter 3.

You may want to click 
the Utility button and 
open the Status Monitor 
window. See page 4-5 
for more information. 
See Chapter 5 for 
instructions on using the 
other utilities available in 
the Utility dialog box.
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What To Do When the Printer 
Lights Flash

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

power button

load/eject button

color cleaning button

black cleaning button

paper out light

color ink out light

black ink out light

power light

 

S When the paper out light flashes, paper is jammed in the 
printer. Turn off the printer and gently pull out all jammed 
paper. Then press the 

 

E load/eject button. See page 6-14 for 
more information.

 

S When the paper out light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press 
the 

 

E load/eject button. 

 

B A When an ink out light flashes, your ink supply is low. Make 
sure you have a replacement cartridge.

 

B A When an ink out light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

 

P When the power light flashes, the printer is receiving a print 
job or performing a maintenance operation.

 

P S B A When two or more lights flash, your printer may have a 
problem. See page 6-9 for more information.
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Your EPSON Stylus COLOR 850Ne lets you print on just 
about any kind of paper you want to use. You can get great 
results printing on various sizes of plain paper, letterhead, and 
envelopes, but you’ll get even better results with specially coated 
ink jet paper.

For the best output, use EPSON’s photo-quality media: ink jet 
paper, glossy paper, glossy film, index cards, and photo paper. 
For special projects, you can use a variety of EPSON media 
designed for ink jet printers, ranging from transparencies to 
iron-on transfer paper. 

Using Special Paper and Media
When you print on special media, you need to be careful about 
choosing the correct Media Type and Paper Size settings in 
your printer software. The table below lists the available 
EPSON media and the corresponding Media Type setting for 
each one in your printer software.

Printing on
Special Paper

Note:
Be careful when printing 
on special paper over the 
network. If anyone else 
sends a job to the printer, 
your paper may be 
wasted. Or, with smaller 
paper, ink may spray 
inside the printer.

EPSON ink jet media and their settings 

Media name Size Part number Media Type setting

EPSON 360 dpi Ink Jet Paper Letter
A4 

S041060
S041059

360 dpi Ink Jet Paper

EPSON Iron-on Cool Peel 
Transfer Paper

Letter S041153/S041155

EPSON Special Coated Paper 
for 360 dpi Printing

Letter S041060
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To order EPSON papers and other media, contact your dealer 
or call EPSON Accessories at (800) 873-7766 (U.S. sales only). 
In Canada, call (800) 873-7766 for dealer referral. Or visit our 
website at www.epsonsupplies.com (U.S. sales only).

EPSON High Quality Ink Jet 
Paper

Letter
A4

S041111
S041117

Photo Quality 
Ink Jet Paper

EPSON Photo Quality Ink Jet 
Paper

Letter
A4
Legal

S041062
S041061
S041067

EPSON Special Coated Paper 
for 720 dpi Printing

Letter S041062

EPSON Photo Quality Ink Jet 
Cards

4.1 × 5.8 (A6)
8 × 10

S041054
S041122

EPSON 720 dpi Index Cards 4.1 × 5.8 (A6) S041054

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106

EPSON Photo Quality Glossy 
Paper

Letter
A4

S041124
S041126

Photo Paper

EPSON Photo Paper 4 × 6
Letter
A4
Panoramic

S041134
S041141
S041140
S041145

EPSON Photo Quality Glossy 
Film

Letter
A4
4.1 × 5.8 (A6)

S041072
S041071
S041107

Photo Quality Glossy 
Film

EPSON High Quality Glossy 
Paper

Letter S041072

EPSON Photo Sticker Kit
(CD-ROM and paper)
EPSON Photo Stickers (refill)

4.1 × 5.8 (A6)

4.1 × 5.8 (A6)

S041144-KIT

S041144

EPSON Ink Jet Transparencies Letter
A4

S041064
S041063

Ink Jet Transparencies

EPSON Iron-On Transfer Paper Letter SE41001/SE41002

EPSON ink jet media and their settings 

Media name Size Part number Media Type setting
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The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. The following tips will help you get the best results on 
any type of paper or other media.

Letterhead, Preprinted Forms, and Legal-size 
Paper

Load the top edge first. When you load long paper, pull up the 
paper support extension and both output tray extensions.

EPSON 360 dpi, High Quality, and Photo 
Quality Ink Jet Paper

You can load paper up to the arrow mark on the left edge guide. 
If you use legal-size ink jet paper, don’t load it more than half 
way to the arrow mark.

Note:
When you load paper, 
make sure the printable 
side is facing up. Some 
special media have a cut 
corner that you need to 
position in the upper right 
of the paper support. Also 
follow any instructions in 
the package. Always 
handle sheets by the 
edges, and don’t touch the 
printable surface.

paper support extension

output tray 
extensions

Caution:
Don’t use the cleaning 
sheets that may be 
included with your special 
media; they may jam 
inside the printer.
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EPSON Photo Quality Glossy Paper, Film, 
and Transparencies

Before you load glossy film or transparencies, put a support 
sheet (packed with the media) or a plain paper sheet beneath the 
stack. (Don’t use a support sheet with Photo Quality Glossy 
Paper.) You can load up to 20 sheets of glossy paper, up to 30 
sheets of glossy film, or up to 10 transparencies. 

However, you may get better results by loading one sheet at a 
time. With multiple sheets loaded, the minimum top margin 
you can use is 1.2 inches (30 mm). If you want to use a smaller 
top margin, load and print one sheet at a time.

Remove each sheet from the output tray immediately after it’s 
printed. Make sure each sheet is dry before stacking. If your 
media package included protective sheets, cover the printed side 
of your media with these sheets before stacking.

To print on transparencies, remove the paper support and 
reposition it in the slots at the back of the paper support holder:

Note:
Use ink jet papers within 
one year of purchase. 
Use glossy media and 
transparencies within six 
months. Return unused 
sheets and envelopes to 
their original package as 
soon as possible. See 
Appendix B for more 
storage information.
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Envelopes

You can load up to 10 envelopes as shown below:

If ink smears when you print on envelopes or other thick media, 
set the paper thickness lever to the + position. Open the printer 
cover and position the lever as shown below. (Make sure you 
return the lever to the 0 position before you print on other 
media.)

Note:
Load the envelopes flap 
edge first and printable 
side up. Also select the 
correct envelope size for 
the Paper Size setting in 
the printer software.

Set the thickness lever 
to + if ink smears 
when you print on thick 
media
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EPSON Photo Paper

You can use EPSON Photo Paper to print photographs that 
look almost as good as the ones you get from film processing. 
4 × 6-inch Photo Paper is perforated around the edges, so you 
can trim your printouts and “bleed” the photo—extend it to the 
edge of the paper—on all sides. 

You can load up to 20 sheets of 4 × 6-inch, Letter-size, or 
A4-size Photo Paper or 1 sheet of Panoramic paper at a time. 
Make sure you place a support sheet beneath the paper if it is 
included in the paper package.

Keep the following in mind when using EPSON Photo Paper:

◗ Load the paper with the whiter side facing up. 

◗ If you’re loading Panoramic Photo Paper, pull up the paper 
support extension as shown on page 2-3. Then load the 
Panoramic paper and hold up its top edge while you press 
the 

 

E load/eject button to feed it into the printer.

◗ If you’re loading 4 × 6-inch Photo Paper, position the 
perforated margins as shown:

Note:
To keep your printouts 
looking their best, store 
them in a resealable 
plastic bag or other 
airtight covering and 
protect them from heat, 
humidity, and direct 
sunlight.

Be sure to support your 
Panoramic Photo Paper 
as it ejects from the 
printer so it doesn’t fall 
onto the floor.
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◗ When you create an image for printing on 4 × 6-inch Photo 
Paper in your application software, size it to 4.25 × 6.25 
inches. For other sizes of Photo Paper, see Appendix B for 
the maximum printable area specifications.

◗ Choose these printer software settings for your size of 
Photo Paper:

◗ Choose Photo Paper as the Media Type setting.

◗ For 4 × 6-inch Photo Paper, select EPSON Photo 
Paper 4 × 6 in as the Paper Size setting and Maximum 
as the Printable Area setting. After you print, fold the 
paper back and forth along the perforations and 
carefully tear the margins off.

◗ For Letter- or A4-size Photo Paper, select Letter or A4 
as your Paper Size setting.

◗ For Panoramic Photo Paper, choose Panoramic 
210 × 594 mm as the Paper Size setting.

EPSON Photo Quality Ink Jet Cards

You can load up to 30 cards at a time. Always place the 
included support sheet under the cards. When you’re ready to 
print, use your software to set the Paper Size option for the 
size card you’re using. Make sure you set the paper thickness 
lever to the + position as shown on page 2-5.

trim size

printed image size

0.67 in

0.24 in
0.12 in

0.24 in0.12 in

You can use 4 × 6-inch 
EPSON Photo Paper like 
a postcard. Simply print 
your image on the glossy 
side of the paper using 
Photo Paper as the Media 
Type setting and let your 
image dry. Then print 
your message on the 
uncoated side of the 
paper using 360 dpi Ink 
Jet Paper as the Media 
Type setting.
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EPSON Photo Quality Self Adhesive Sheets

Use these sheets to print labels or stickers. You can load one 
sheet at a time. Make sure your adhesive sheets are fully adhered 
to their backing sheet before you load them.

EPSON Iron-On Transfer Paper

You can print photos, company logos, or anything else you 
want on this paper, and then transfer your images to T-shirts or 
other cloth items. Load one sheet of transfer paper at a time. 
After you print, follow the instructions that came with the 
paper to iron the image onto the shirt or other item.

Be sure to select Ink Jet Transparencies as the Media Type 
setting for the best results.

For iron-on transfers, 
make sure you reverse 
your image before you 
print it, especially if it 
includes text. Then the 
text will read correctly 
when it’s transferred. 
You can use the Flip 
Horizontal option in your 
printer software. See 
page 3-6 for more 
information.
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When your presentation graphics, photographs, or other 
projects have special printing requirements, you can use the 
custom settings in your EPSON Stylus COLOR 850 software. 
You can choose predefined settings or adjust individual options 
like brightness, contrast, saturation, and halftoning. For 
professional-quality color accuracy, you can use Image Color 
Matching (ICM) under Windows 98 and Windows 95 or 
ColorSync on the Macintosh.

If you’re using Windows 98, Windows 95, Windows NT, or a 
Macintosh, your printer software’s print layout options let you 
print almost any size image on your printer, proof multiple 
pages on one sheet of paper, and add watermarks.

This chapter includes the following information:

◗ Using predefined advanced settings

◗ Customizing print quality and special effects

◗ Customizing color settings

◗ Using ColorSync on the Macintosh

◗ Selecting paper size and orientation options

◗ Selecting print layout, page frame, and watermark options

◗ Saving custom settings

Custom Printing
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Using Predefined Advanced 
Settings
Predefined settings provide an easy way to fine-tune your 
printer’s operation for special image types. Follow these steps to 
print with predefined settings:

1. Create your image or document in your application.

2. Access the printer settings dialog box: choose Print from 
your application’s File menu. (You may need to choose 
Page Setup for Macintosh.)

For Windows, click the Printer, Setup, Properties, or 
Options button. (For more detailed instructions, see 
page 1-2 [Windows] or page 1-7 [Macintosh].)

You see one of the following dialog boxes:

3. Choose Color or Black ink.

4. Click Advanced, and then Custom Settings. You see the 
list of project types.

Windows

Click Advanced, then click here to 
see a list of project types

MacintoshClick Advanced, then click here 
to see a list of project types
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5. Choose the right setting following these guidelines:

◗ Photo
For printing scanned photographs. Increases contrast 
in the image.

◗ Text/Graph
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights.

◗ PhotoEnhance2 or
PhotoEnhanceTM (Windows 3.1 only) 
For video camera, digital camera, or scanner images. 
Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and 
brightness. Corrects for overall under- and 
over-exposure of the original image.

◗ Economy
For rough drafts of text only, on plain paper. Saves ink. 

◗ ICM (Windows 98/Windows 95 only)
Automatically adjusts printout colors to match the 
colors on your screen. Not available when printing on 
plain paper or Ink Jet Transparencies.

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match the 
colors on your screen. Not available when printing on 
plain paper or Ink Jet Transparencies. For more 
information, see page 3-9.

6. Choose the Media Type you want to print on. (If you’re 
not sure which setting to select, see the table on page 2-1.)

7. In Windows, click the Paper and Layout (not available on 
Windows 3.1) tabs to check or change any necessary 
settings, as described on page 3-11 and page 3-15. 

On a Macintosh, check or change any necessary settings on 
the Page Setup and the Layout dialog boxes as described on 
page 3-15 and page 3-27.

Note:
Always choose your Ink 
setting before you select a 
project from the Custom 
Settings list.

Selecting PhotoEnhance or 
PhotoEnhance2, 
ICM, or ColorSync 
automatically sets the Ink 
option to Color.

Printing with PhotoEnhance 
or PhotoEnhance2 may take 
longer, depending on your 
computer system and 
image.

Photo, PhotoEnhance, and 
PhotoEnhance2 have 
similar effects. However, 
PhotoEnhance and 
PhotoEnhance2 
intelligently analyze your 
image data and their 
effect varies widely 
depending on your image. 
The Photo setting 
consistently increases the 
contrast. You may want to 
experiment to choose the 
best setting for your 
image.
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8. When you’re finished, click Print (Macintosh) or OK 
(Windows). If you’re using Windows, click any other 
buttons that your application uses for printing.

Customizing Print Quality and 
Special Effects
If you need the maximum control over your project, or you 
want to experiment with special effects, you can adjust 
individual settings in your printer software. Follow these steps:

1. Create your document, image, or project in your 
application software.

2. Access the printer settings dialog box: choose Print from 
your application’s File menu. (You may need to choose 
Page Setup for Macintosh.)

For Windows, click the Printer, Setup, Properties, or 
Options button. (For more detailed instructions, see 
page 1-2 [Windows] or page 1-7 [Macintosh].)

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box:

After you customize your 
print settings for a special 
project, you can save 
them as a group. Then 
you can reuse them 
whenever you print a 
similar project. See 
page 3-33 for instructions.

Macintosh

Some of these options 
are automatically set or 
disabled by other 
settings you choose

Click here to change your 
Print Quality (resolution)
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4. Choose one of the following Print Quality options:

◗ Economy
For low-resolution rough drafts on plain paper. Saves 
ink.

◗ Normal - 360 dpi
For most documents on plain paper, transparencies, or 
360 dpi Ink Jet paper.

◗ Fine - 720 dpi
For high-resolution output on plain paper, Photo 
Paper, or Photo Quality media.

◗ SuperFine - 1440 dpi
For the highest-resolution output on plain paper, 
Photo Paper, or Photo Quality media.

5. Choose the Media Type and Ink settings you want to use, 
following the guidelines in Chapters 1 and 2. 

Windows

Some of these options 
are automatically set or 
disabled by other 
settings you choose

Click here to change your 
Print Quality (resolution)

Note:
The Print Quality is selected 
automatically depending on 
the current Media Type. If 
you choose a Print Quality 
setting that is not 
appropriate for your media, 
the driver changes the 
Media Type setting. Be sure 
to check both of these 
settings.
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6. Choose one of the following Halftoning options:

◗ No Halftoning
For printing black text only.

◗ Error Diffusion
For printing photographic or video/digital camera 
images. Blends each color dot with the dots around it.

◗ Fine Dithering, Coarse Dithering
For printing graphs or other images that require 
precise, solid areas of bright colors. Use Coarse for 
images with more shading and less detail. Use Fine for 
images with more detail and less shading.

7. Choose any of the following print options. 

◗ MicroWeave
For improved print quality. Prints graphic data in finer 
increments to eliminate unwanted banding effects 
(light horizontal lines). Always use for color printing.

◗ Super MicroWeave
Increases the MicroWeave function when you’re 
printing with Fine - 720 dpi Print Quality on plain 
paper or using SuperFine - 1440 dpi with photo 
paper or one of the photo quality media. 

◗ High Speed
For fast, bidirectional printing at lower quality.

◗ Flip Horizontal
Prints a mirror image of your document. Use for 
printing with iron-on transfer paper so your ironed-on 
printout will read correctly.

◗ Finest Detail
For printing text, graphics, and line art with very sharp 
edges. Slows print speed and increases your system 
memory requirements. 

8. Click OK if you’re ready to return to the printer settings 
dialog box, or see the next section if you want to adjust 
your printer’s color settings.

Note:
In Automatic mode, the 
Halftoning setting is 
selected based on the data 
in your print job. In 
Advanced mode, Halftoning 
is preselected for each 
project type setting. No 
Halftoning is available only 
when you select Black as 
the Ink setting.

Some of the print options at 
the bottom left of the More 
Settings window are 
automatically selected or 
disabled by the Print Quality 
(resolution) you choose.

If vertical lines in your 
printout are misaligned 
when you use the High 
Speed setting, you may 
need to align the print 
heads. See Chapter 5 for 
instructions.
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Customizing Color Settings
Choose from several color adjustment modes or manually 
adjust brightness, contrast, saturation, and CMY color values. 
Or, to correct digital images, you can use PhotoEnhance2 
(PhotoEnhance on Windows 3.1). To achieve the maximum 
color accuracy, you can use Image Color Matching (ICM; 
Windows 98/Windows 95) or ColorSync (Macintosh).

Follow these steps to customize your color settings:

1. Create your document, image, or project in your 
application software.

2. Choose Print from your application’s File menu. (You may 
need to choose Page Setup for Macintosh.)

For Windows, click the Printer, Setup, Properties, or 
Options button. (For more detailed instructions, see 
page 1-2 [Windows] or page 1-7 [Macintosh].)

3. Click Advanced, and then click More Settings. You see 
the More Settings dialog box. The color settings appear on 
the right side of the dialog box, as shown:

Windows

Click to set a Color Adjustment Mode

Drag 
sliders to 
set values 
between 
-25% and 
+25%

Click to set a Color Adjustment Mode

Macintosh
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4. Choose one of the following Color Adjustment Modes. 
(You don’t need to select any of these options if you’ll be 
using ICM [Windows 98/Windows 95] or ColorSync 
[Macintosh] as described in step 4.)

◗ Automatic
Analyzes the color information in your project and 
optimizes color correction accordingly.

◗ Photo-realistic
For printing color photographs. 

◗ Vivid
For printing graphics-intensive documents like 
presentation pages with charts and graphs. Intensifies 
colors and lightens the midtones and highlights. 

◗ No Color Adjustment 
Disables the color adjustment features of the printer 
software so you can use a stand-alone color 
management utility. 

5. If you want to specify individual color correction values, 
use the sliders to increase (drag right) or decrease (drag left) 
the settings listed below. (If you use one of the options 
described in step 4, you won’t be able to specify individual 
color correction values.)

◗ Brightness
Makes your image lighter or darker.

◗ Contrast
Increases or decreases the difference between the bright 
or dark parts of an image.

◗ Saturation
Makes colors more vivid or less vivid.

◗ Cyan, Magenta, Yellow
Increases or decreases the amount of the three ink 
colors that combine to make a full-color picture. Use 
these sliders to fine-tune the color balance in your 
printout.
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6. For even more fine-tuning, choose one of these color 
correction methods:

◗ PhotoEnhance2 or
PhotoEnhance (Windows 3.1 only)
Produces sharper images and more vivid colors by 
automatically adjusting the contrast, saturation, and 
brightness. Corrects for overall under- and 
over-exposure of the original image. 

◗ ICM (Windows 98/Windows 95 only)
Automatically adjusts printout colors to match colors 
on the screen. 

◗ ColorSync (Macintosh only)
Automatically adjusts printout colors to match colors 
on the screen. See the next section for more 
information.

7. Click OK to return to the printer settings dialog box.

Using ColorSync on the Macintosh 
Every device you use for producing or viewing colors—your 
monitor, scanner, and printer—employs a different color 
technology. That’s why it’s difficult to get printed colors to 
match the colors displayed on your monitor or other device. 
The Macintosh ColorSync system helps you control all your 
devices so their colors match your printer’s as closely as possible. 

ColorSync uses profile information from each device—
including your EPSON Stylus COLOR 850Ne printer—to 
achieve accurate color matching. First you have to make sure 
your monitor’s profile is set. Then you can use your printer 
software to specify the exact method of color matching you 
want to use.

Note:
When you choose 
PhotoEnhance, 
PhotoEnhance2, ICM, 
ColorSync, or No Color 
Adjustment all the other 
color options are preset.
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Follow these steps to set your monitor’s ColorSync profile and 
use your printer software’s ColorSync features:

1. Open the ColorSync System Profile under Control 
Panels on the Apple menu.

2. Click the Set Profile button.

3. Select your monitor from the list, and then click Select.

4. Close the ColorSync System Profile.

5. Access the More Settings dialog box as described on 
page 3-4. 

6. Click ColorSync.

7. For Profile, choose EPSON Standard. This is the 
ColorSync profile created especially for your printer. Don’t 
choose any other printer profile you may have on your 
system.

8. Choose one of the following options for Rendering Intent:

◗ Perceptual
For printing scanned photographs. 

◗ Saturation
For printing graphics-intensive documents like 
presentation pages with charts and graphs. 

◗ Colorimetric
For matching colors on your screen as exactly as 
possible. Reproduces colors the way your eye 
distinguishes them.

9. Click OK to return to the printer settings dialog box.
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Selecting Paper Size and 
Orientation Options
Your printer can print on paper up to 9.5 inches wide and up to 
44 inches long in either portrait or landscape orientation. For 
multiple page documents or multiple copies of documents, you 
can print the pages collated and in reverse order. You can even 
rotate the printed image by 180 degrees to make it closer to the 
bottom of the paper (not available with Windows 3.1).

Selecting Paper Options in Windows

Follow these steps to select paper options on the Paper tab:

1. Create your document, image, or project in your 
application software.

2. Choose Print from your application’s File menu. (You may 
need to choose Page Setup for Macintosh.)

For Windows, click the Printer, Setup, Properties, or 
Options button. (For more detailed instructions, see 
page 1-2 [Windows] or page 1-7 [Macintosh].)

3. Click the Paper tab. You see the Paper dialog box:

Click to select your 
Paper Size 

Printer graphic reflects 
changes to Orientation 
and Printable Area settings Rotate by 180° is not 

available with 
Windows 3.1

Page graphics 
change to show 
Collate and Reverse 
Order settings
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4. Click the Paper Size drop-down list to select the size of 
paper you loaded in the printer. 

The sizes marked with an asterisk (*) are not available with 
Windows 3.1. These sizes are larger than you can load in 
your printer and can be used only with the Proportional 
Printing setting on the Layout tab; see page 3-20.

A4 210 × 297 mm
B5 182 × 257 mm
A5 148 × 210 mm
Letter 8 1/2 × 11 in
Legal 8 1/2 × 14 in
Executive 7 1/4 × 10 1/2 in
Half Letter 5 1/2 × 8 1/2 in
A6 Index card 105 × 148 mm
Index card 5 × 8 in
Index card 8 × 10 in
Envelope #10 4 1/8 × 9 1/2 in
Envelope DL 110 × 220 mm
Envelope C6 114 × 162 mm
Photo Paper 4 × 6 in
Panoramic 210 × 594 mm
B4 257 × 364 mm *
B3 364 × 514 mm *
Ledger 11 × 17 in *
A3 297 × 420 mm *
Super A3/B 329 × 483 mm *
A2 420 × 594 mm *
US C 17 × 22 in *
User Defined (See page 3-14 for instructions.)

5. If you did not or cannot select the number of copies you 
want to print in your application program’s Print dialog 
box, choose the number (from 1 to 99) in the Copies box. 
Don’t select the number of copies here and in your 
application’s Print dialog box; you’ll get twice the number 
of copies you want.

Note:
If the Proportional Printing 
setting is set to Normal and 
you select one of the paper 
sizes to the right that is 
marked with an asterisk (*), 
you see a dialog box asking 
you to select a paper size 
that fits your printer. See 
page 3-20 for more 
information.
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6. If you’re printing multiple copies of a multi-page document 
and you want the copies printed in sets, click the Collate 
checkbox. The page graphics change to show collated 
documents.

7. If you’re printing a multi-page document and want the last 
page printed first so the pages come out without needing to 
be reordered, click the Reverse Order checkbox. The page 
graphics change to show later pages printing first.

8. Select the direction of printing on the page using the 
Orientation options. To print your document oriented as 
shown in one of the following printer graphics, select the 
options listed below it.

9. To use the maximum printable area of your selected paper 
size, set the Printable Area option to Maximum. To center 
your document on the page, select Centered.

10. Click a tab for the settings you want to check or change 
next, or click OK to print your document.

Note:
The Rotate by 180° setting 
lets you print the lower 
portion of a document first, 
with a bottom margin as 
small as 0.12 inch (3 mm) 
and a top margin as small as 
0.55 inch (14 mm). This 
option is not available with 
Windows 3.1. Portrait orientation Landscape orientation

Portrait orientation
Rotate by 180°

Landscape orientation
Rotate by 180°
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Creating User Defined Paper Sizes

You can create up to 10 custom paper sizes (only one in 
Windows 3.1) and add them to the Paper Size list using the 
User Defined option. This is useful if you’re printing a custom 
size document, such as a banner. You can select any width from 
3.94 to 9.5 inches, and any height (length) from 3.94 to 
44 inches.

Follow these steps to create a custom paper size with the User 
Defined option:

1. Follow the steps on page 3-11 to access the printer software 
and select the Paper tab.

2. Click the Paper Size list and scroll to the bottom of it 
using the arrows or scroll bar. 

3. Click the User Defined option. You see one of the 
following dialog boxes:

4. Windows 98, Windows 95, or Windows NT
Type a name (up to 24 characters) for your custom paper 
size in the Paper Size Name field. Then select a Paper 
Width and Paper Height for the paper. To use centimeters 
instead of inches, click the 0.01cm option. When you’re 
finished, click Save. The paper size name appears in the 
Paper Size list in the dialog box. Add more sizes if you 
want, and click OK when you’re done.

Note:
In Windows 98, 
Windows 95, and 
Windows NT, the Paper 
Width and Paper Height 
units are in hundredth of an 
inch (or centimeter) 
increments. For example, 
850 equals 8.50 inches.

Windows 95/Windows NT

Windows 3.1
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Windows 3.1
You can create only one User Defined paper size. Type the 
width in the Paper Width field and the length in the 
Paper Height field. Then click OK.

5. You see the Paper tab again. The paper size name you 
defined is added to the Paper Size list and selected as the 
current setting. (In Windows 3.1, the setting is named 
User Defined.)

6. To change or delete a custom paper size: 

Windows 98, Windows 95, or Windows NT
Click User Defined in the Paper Size list. Then, on the 
User Defined Paper Size dialog box, select the custom 
paper name in the Paper Size list and click Delete or 
change Paper Width, Paper Height, and/or Unit settings 
as necessary. Click OK when you’re done.

Windows 3.1
You can change the custom paper size, but cannot delete it. 
Click User Defined in the Paper Size list. Then, on the 
User Defined Paper Size dialog box, change Paper Width 
and Paper Height settings as necessary. Click OK when 
you’re done.

Selecting Paper Options on a Macintosh

The Paper Size and Orientation options for your printer 
software are on the Page Setup dialog box. The options for 
collating and reversing the page order are on the Layout dialog 
box. Follow the steps in these sections for selecting the paper 
options:

◗ Choosing paper size and orientation options

◗ Selecting print order options
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Choosing Paper Size and Orientation Options

Follow these steps to select the Paper Size and Orientation 
options:

1. Create your image or document in your application.

2. Open the File menu and select Page Setup. You see the 
Page Setup dialog box:

3. Click the Paper Size pop-up list to select the size of paper 
you loaded in the printer. 

A4 Envelope C6 
B5 Envelope DL
A5 A6 Index card 
Letter Index card 5×8in 
Legal Index card 8×10in
Executive EPSON Photo Paper 4×6in
Half Letter Panoramic 210×594mm
Envelope #10 

If you don’t see the exact size you need in the list, you can 
create a custom paper size; see page 3-18 for instructions.

Click to select 
your Paper Size 

Printer graphic reflects changes to 
Orientation and Printable Area settings

Click to select 
your Orientation 
options
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4. Select the direction of printing on the page using the 
Orientation options. To print your document oriented as 
shown in one of the following printer graphics, select the 
options listed below it.

5. To use the maximum printable area of your selected paper 
size, set the Printable Area option to Maximum. To center 
your document on the page, select Centered.

6. If you want to collate multiple copies of a multi-page 
document or you want to reverse the order in which pages 
are printed, click OK. Then see page 3-19 for instructions.

If you’ve finished selecting page size and orientation 
options, click OK to close the Page Setup dialog box. Then 
select Print from the File menu to select any other printer 
settings you may need and print your document.

Note:
The Rotate by 180° setting 
lets you print the lower 
portion of a document first, 
with a bottom margin as 
small as 0.12 inch (3 mm) 
and a top margin as small as 
0.55 inch (14 mm).

Portrait orientation Landscape orientation

Portrait orientation
Rotate by 180°

Landscape orientation
Rotate by 180°
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Creating custom paper sizes

You can create up to 8 custom paper sizes and add them to the 
Paper Size list. This is useful if you’re printing a custom size 
document, such as a banner. You can select any width from 
3.94 to 9.5 inches, and any height (length) from 3.94 to 
44 inches.

Follow these steps to create a custom paper size:

1. Follow the steps on page 3-16 to access the Page Setup 
dialog box.

2. Click the Customize button. You see the following dialog 
box:

3. Click the New button. Width and Height fields and 
Inches and cm radio buttons appear on the screen.

4. Type the width and length of your custom paper in the 
Width and Height fields. If you need to change from 
inches to centimeters, click the correct radio button.

5. Type a name for your custom paper size in the New Paper 
Size field, then click OK. The name is added to the Paper 
Size list and selected as the current setting in the Page 
Setup dialog box. 

6. To delete a custom paper size, click the Customize button. 
Then click the name of the custom paper size, and click 
Delete. Click OK to return to the Page Setup dialog box.
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Selecting Print Order Options

Follow these steps to use the Collate and Reverse Order 
options:

1. Open your application’s File menu and select Print.

2. Click the Layout button. You see the Layout dialog box:

3. If you’re printing multiple copies of a multi-page document 
and you want the copies printed in sets, click the Collate 
checkbox. The page graphics change to show collated 
documents.

4. If you’re printing a multi-page document and want the last 
page printed first so the pages come out without needing to 
be reordered, click the Reverse Order checkbox. The page 
graphics change to show later pages printing first.

5. Click OK to close the Layout dialog box.

Note:
For information on the other 
settings on the Layout 
dialog box, see page 3-27.

Print Order options
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Selecting Print Layout Options
Your printer software’s print layout options let you reduce or 
enlarge almost any size document to print on your printer. You 
can also select options to proof multiple pages on one sheet of 
paper, add page frames, and add a predefined or custom 
watermark.

For Windows 98, Windows 95, and Windows NT instructions, 
see the next section. For Macintosh instructions, see page 3-27.

Choosing Print Layout Options in Windows

Follow the steps in these sections to use options in the Layout 
dialog box:

◗ Using proportional printing

◗ Using multiple print layouts and page frames

◗ Adding a watermark

Using Proportional Printing

When you want to make the printed size of a document 
different from its actual size, you can use your printer software’s 
proportional printing features to reduce or enlarge it. You can 
proportion the document to fit in the maximum, centered area 
on a selected paper size. You can also choose to reduce or 
enlarge it to a selected percentage.

Follow these steps to use proportional printing:

1. Follow the steps on page 3-11 to access the printer software 
and select the Paper tab.

2. Click the Paper Size list and select the actual size of the 
document you want to print. 

Note:
Layout options are available 
only when you’re using 
Windows 98, Windows 95, 
Windows NT, or a 
Macintosh.
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For example, if your document size is 11 × 17 inches, select 
Ledger 11 × 17 in. This paper size is too large to fit in your 
printer, so you’ll need to proportion it to fit on a smaller 
paper size (by reducing the document size). If your 
document size is 5 × 8 inches, but you want it to fit in the 
maximum area on Letter-size paper, you’ll need to 
proportion it to fit on a larger paper size (by enlarging the 
document size).

3. If the Paper Size setting you selected for your document is 
within the maximum paper size that can fit on your printer, 
but you want to enlarge or reduce the image, you need to 
select proportional printing manually. Go to step 5.

4. If the Paper Size setting you selected is larger than the 
maximum size that can be printed on your printer, you see 
the following dialog box:

In the Output Paper list, select the actual size of the paper 
loaded in the printer and click OK. This automatically 
turns on proportional printing and sets the correct 
reduction percentage so the document fits into the 
maximum, centered printable area on the output paper you 
select. 
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The selected Paper Size, reduction percentage, and 
Output Paper settings now appear on the printer graphic. 
If you want to adjust the proportions or sizes, go to step 5. 
If you’re ready to print, go to step 7.

5. Click the Layout tab. You see the Layout dialog box:

Paper Size setting

reduction percentage

Output Paper setting

Proportional 
Printing options

Windows 98 and 
Windows 95
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6. Select one of the following proportional printing options:

◗ Select Normal to set the print proportion to 100%. 

◗ Select Fit to Page to automatically reduce or enlarge 
the document to fit on the paper size loaded in the 
printer. The Paper Size option beneath the Fit to 
Page option becomes active; select the size of paper 
loaded in the printer.

◗ Select Custom to reduce or enlarge the image by a 
specific percentage (10% to 400%).

7. If you’re finished selecting Layout options, click OK.

If you want to select more options, see the next sections.

Using Multiple Print Layouts and Page Frames 
(Windows 98 and Windows 95 Only)

If you’re printing a multiple page document, but you want a 
quick proof of the images on each page printed on one piece of 
paper, you can select Print Layout options in the printer 
software. You can choose the way the pages are placed on the 
paper and add a lined frame to each page, if you want.

Note:
If you previously selected a 
Paper Size setting that is 
larger than the maximum 
paper size for your printer 
and then choose Normal, 
the printer software 
changes the Paper Size to 
Letter 8 1/2 × 11 inches. Select Fit to Page, 

then select the size 
of paper loaded in 
the printer here

Note:
You can’t select a multiple 
print layout option if you’re 
using a proportional printing 
option (either Fit to Page or 
Custom).
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Follow these steps to use the Print Layout options:

1. To print multiple pages of your document on one sheet of 
paper, select either the 2 Pages or 4 Pages radio button.

2. If the page order of the layout shown in the printer graphic 
is how you want your document printed, go to step 3.

To change the page order, click the Page Order button. 
Then select the page order you want to use from the Print 
Layout dialog box that appears.

3. If you want to frame each page’s contents with a black line, 
one dot wide, click the Print page frames checkbox.

4. If you’re finished selecting Layout options, click OK.

If you want to select more options, see the next section.

Adding a Watermark

You can add a watermark to each page in your document to 
emphasize its purpose or indicate how the document should be 
handled. For example, you may want to add a watermark of the 
word “Confidential” to documents you don’t want distributed 
to other parties. Or you can add a custom bitmap of your 
company logo so your document looks like printed letterhead.

Click the button to 
select a multiple 
page print layout

Note:
You can select a page order 
only if it works with the 
proportion of your selected 
Paper Size and/or your 
current orientation setting, 
either Portrait or 
Landscape. 

Note:
To add a custom watermark, 
you must first create the 
watermark as a bitmap in an 
application program that can 
create bitmap files. See your 
application’s documentation 
for instructions.
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Follow the steps in the correct section below to add a 
predefined or custom watermark.

1. To turn on the watermark feature, click the Watermark 
checkbox. 

2. The default watermark is Confidential. To change the 
watermark or specify how it appears, click the Watermark 
Settings button. You see the following dialog box:

3. To select a different predefined watermark, click the arrow 
in the Watermark drop-down list and choose one of the 
following options:

Confidential
Draft
Urgent
Priority
Hot
Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate

Then go to step 5.

Click here to select a 
predefined watermark

Click here to load a 
custom watermark 
you’ve created

Specify how you want 
your watermark to 
appear using these 
options

See how your 
selections will look 
in the Layout 
graphic shown 
here

Note:
If you selected a multiple 
page print layout option (as 
described on page 3-29), 
your watermark will appear 
on each page in the layout.
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4. To load a custom watermark you’ve created as a bitmap in 
an application program, click the User Defined button. 
You see the following dialog box:

Click the Browse button. You see the Select a bitmap file 
dialog box. Navigate to the folder containing the bitmap 
file you want to use, select the file, and click OK.

Type a name for the custom watermark (up to 24 
characters long) in the Watermark field. Click the Save 
button to add it to the list, then click OK.

The custom watermark now appears as the selected 
watermark in the Watermark Settings dialog box and is 
shown in the Layout graphic.

5. Now select the way you want the watermark to appear by 
choosing the following options. The Layout graphic 
changes to reflect all the settings you choose.

◗ Position selects where you want the watermark to 
appear on your page: Center, Top-Left, Top-Right, 
Bottom-Left, or Bottom-Right. 

◗ Size adjusts the size of the watermark, either larger or 
smaller, as you move the slide bar.

◗ Color lets you choose a color for your predefined 
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia, 
or Yellow. You cannot select a color for a custom 
watermark; it is printed in its original colors.

Click Browse to select 
your bitmap file

Then type a name for your 
custom watermark here 
and click Save

Note:
You can create up to 10 
custom watermarks. In 
Windows 98 and 
Windows 95, you can use 
any bitmap file up to 15MB 
in size. With Windows NT, 
the file can be any size.

To delete a custom 
watermark you’ve added to 
the list, click the User 
Defined button. Then select 
the watermark and click 
Delete. Click OK to close the 
dialog box.

Note:
If your monitor displays only 
16 colors, the Intensity 
adjustments are not shown 
in the Layout graphic. If you 
choose the No Halftoning 
setting, the Intensity setting 
does not determine how 
your watermark is printed.
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◗ Intensity sets the lightness or darkness of the 
watermark (from 5% to 100%) based on where you 
move the slide bar. 

6. If you’re finished changing Layout options, click OK to 
close the Layout dialog box.

Choosing Print Layout Options on a 
Macintosh

Follow the steps in these sections to use options in the Layout 
dialog box:

◗ Using the Fit to Page option

◗ Using multiple print layouts and page frames

◗ Adding a watermark

Using the Fit to Page Option

When you want to make the printed size of a document 
different from its actual size, you can use your printer software’s 
Fit to Page option to proportion it to fit in the maximum, 
centered area on a selected paper size. 

Follow these steps to use the Fit to Page option:

1. Create your image or document in your application 
software.

2. Open the File menu and select Page Setup. You see the 
Page Setup dialog box.

3. Click the Paper Size list and select the actual size of the 
document you want to print. For example, if your 
document size is 8 1/2 × 11 inches, select Letter for the 
Paper Size option.
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If you want to print this document at the maximum size on 
4 × 6-inch EPSON Photo Paper, you’ll use the Fit to Page 
option to reduce the image to that size. If you want to print 
this image at the maximum size on Legal-size paper 
(8 1/2 × 14 inches), you’ll use the Fit to Page option to 
enlarge the document to that size.

4. Click OK to close the Page Setup dialog box.

5. Now open the File menu and select Print.

6. Click the Layout button. You see the Layout dialog box:

7. Select one of the following Fit to Page options:

◗ Select Off to set the print proportion to 100%.

◗ Select On to automatically reduce or enlarge the 
document to fit on the paper size loaded in the printer. 

Fit to Page 
options
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The Paper Size option beneath the Fit to Page option 
becomes active. 

Now select the size of the paper you’ve loaded in the 
printer. This automatically sets the correct reduction or 
enlargement percentage to fit the document into the 
maximum, centered area on the selected paper size. The 
selected document size and paper size settings now appear 
beneath the printer graphic. 

8. If you’re finished selecting Layout options, click OK.

If you want to select more options, see the next sections.

Using Multiple Print Layouts and Page Frames

If you’re printing a multiple page document and you want a 
quick proof of the images on each page printed on one piece of 
paper, you can select Print Layout options in the printer 
software. You can choose the way the pages are placed on the 
paper and add a lined frame to each page, if you want.

Follow these steps to use the Print Layout options:

1. To print multiple pages of your document on one sheet of 
paper, select either 2 Pages or 4 Pages in the Pages 
pop-up list.

Select the paper size you’ve 
loaded in the printer here

Printer graphic displays the selected 
paper size and 
document size

Note:
You can’t select a multiple 
print layout option if you’re 
using the Fit to Page option.
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2. If the page order of the layout shown in the printer graphic 
is how you want your document printed, go to step 3.

To change the page order, click the arrow in the Page 
Order pop-up list. Then select the page order you want to 
use.

3. If you want to frame each page’s contents with a black line, 
one dot wide, click the Print page frames checkbox.

4. If you’re finished selecting Layout options, click OK.

If you want to select more options, see the next section.

Adding a Watermark

You can add a watermark to each page in your document to 
emphasize its purpose or indicate how the document should be 
handled. For example, you may want to add a watermark of the 
word “Confidential” to documents you don’t want distributed 
to other parties. Or you can add a custom PICT file of your 
company logo so your document looks like printed letterhead.

Click the arrow and select a 
multiple page print layout

Note:
You can select a page order 
only if it works with the 
proportion of your selected 
Paper Size and/or your 
current orientation setting, 
either Portrait or Landscape. 

Note:
To add a custom watermark, 
you must first create the 
watermark as a PICT file in 
an application program that 
can create PICT files. See 
your application’s 
documentation for 
instructions.
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1. To use one of the predefined watermarks, click the arrow in 
the Name pop-up list in the Watermark box. Then choose 
one of the following options:

Confidential
Draft
Urgent
Priority
Hot
Do Not Copy
For Your Eyes Only
Review Copy
Top Secret
Duplicate

Then go to step 3.

2. To load a custom watermark you’ve created as a PICT file 
in an application program, click the Add/Delete button. 
You see the following dialog box:

Click the Add button. You see a dialog box for selecting 
files. Navigate to the folder containing the PICT file you 
want to use, select the file, and click Open.

The name of your PICT file appears in the Name field and 
is added to the Watermark List. Click the Save button to 
close the dialog box.

The custom watermark now appears as the selected 
watermark in the Layout dialog box and is shown in the 
Layout graphic.

Note:
If you selected a multiple 
page print layout option (as 
described on page 3-29), 
your watermark will appear 
on each page in the layout.

Click the Add button to 
select a PICT file 

Note:
You can create up to 10 
custom watermarks from 
PICT files up to 1MB in size. 

To delete a custom 
watermark you’ve added to 
the list, click the Add/Delete 
button. Then select the 
watermark and click Delete. 
Click Save to close the 
dialog box.
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3. Now select the way you want the watermark to appear by 
choosing the following options. The Layout graphic 
changes to reflect all the settings you choose.

◗ Color lets you choose a color for your predefined 
watermark: Red, Black, Blue, Aqua, Lime, Fuchsia, 
or Yellow. You cannot select a color for a custom 
watermark; it is printed in its original colors.

◗ Intensity sets the lightness or darkness of the 
watermark (from 5% to 100%) based on where you 
move the slidebar. 

◗ To adjust the size and position of the watermark, move 
the cursor over the Layout graphic. Four boxes appear 
in the corners of the graphic and the cursor changes to 
a hand.

To move the watermark, click anywhere inside the 
graphic and drag it into one of five positions: center, 
upper-right, upper-left, lower-right, or lower-left.

To resize the watermark, move the cursor over one of 
the corner boxes; the cursor changes to a pointing 
hand. Click and drag the box corner to reduce or 
enlarge the watermark.

4. If you’re finished changing Layout options, click OK to 
close the Layout dialog box.

Note:
If your monitor displays only 
16 colors, the Intensity 
adjustments are not shown 
in the Layout graphic. If you 
choose the No Halftoning 
setting, the Intensity setting 
does not determine how 
your watermark is printed.

Click and drag 
anywhere in here to 
move the watermark

Click and drag one of 
the corner boxes to 
resize the watermark
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Saving Custom Settings
After you’ve fine-tuned your printer settings for a special 
project, you can save the settings as a group. Then you can 
quickly reuse them the next time you print a similar project. 
You can save up to 10 (Windows) or 8 (Macintosh) groups of 
settings. Follow these steps:

1. Customize your printer settings as described in this chapter.

2. Click the Save Settings button on the main printer 
software dialog box. You see one of the following:

 

3. Type a unique name for your settings (up to 16 characters) 
and click the Save button.

The name you choose will now be available on the printer 
settings dialog box. To use the settings, click Advanced. Then 
open the Custom Settings list and double-click the name you 
selected for your custom settings group.

To redefine or delete your custom settings, see the next sections.

Macintosh

Windows

Note:
If you change the Media 
Type or Ink setting when 
your customized setting is 
selected, the setting 
selected in the list changes 
to Custom Settings. This 
does not affect your 
customized setting. To 
return to your customized 
setting, simply reselect it.
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Redefining Custom Settings

To change the options in a customized settings group but keep 
the same name for it, follow these steps:

1. Select Advanced mode. Then select the name of the 
custom settings group you want to redefine in the Custom 
Settings list.

2. Change the printer settings as necessary. (If you change the 
Media Type and Ink settings, the custom settings group 
name reverts to Custom Settings; this doesn’t affect your 
customized setting.)

3. Click Save Settings. Then select the name of the custom 
settings group you’re redefining in the Custom Settings 
box.

4. If you’re using Windows, click Save. You see the Save As 
dialog box. Click OK to save your redefined settings. (Click 
Cancel to cancel your changes.)

On a Macintosh, click the Redefine button. Then click 
Replace at the confirmation dialog box to save your 
redefined settings. (Click Cancel to cancel your changes.)

Deleting Custom Settings

1. Select Advanced mode. Then click Save Settings.

2. Select the custom settings group in the Custom Settings 
box, and click Delete. (You cannot delete any of the 
predefined document types.)
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Your printer software includes several utilities for managing 
print jobs. You can use them to monitor your printer’s status, 
schedule large jobs to print later, and handle network printing. 

This chapter provides instructions for the following:

◗ Managing print jobs in Windows 98, Windows 95, and 
Windows NT 4.0

◗ Managing print jobs in Windows 3.1

◗ Managing print jobs on a Macintosh

If you are the network administrator, see the Administrator’s 
Guide for more information on using EPSON Status Monitor 2 
with your network.

Managing Print Jobs in Windows 98, 
Windows 95, and Windows NT 4.0
Your printer software offers several ways to manage and 
monitor your print jobs:

◗ EPSON Status Monitor 2 (Windows 98, 95, and NT), 
which provides a variety of print monitoring options, as 
described on page 4-2.

◗ Progress Meter (Windows 98 and 95), which appears each 
time you send a print job. You can turn the Progress Meter 
on or off and select other printing options using the Speed 
& Progress button; see page 4-9 for details.

Managing
Print Jobs

Note:
You can only monitor 
your printer if you 
installed both the 
network part and the 
printer-specific part of 
Status Monitor 2. See 
page 13 in the Setup 
Guide.
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◗ Spool Manager (Windows 98 and 95), which appears in the 
Taskbar at the bottom of the screen each time you print, as 
described on page 4-11.

◗ Additional monitoring features for Windows NT 4.0, 
which are discussed briefly on page 4-12.

Using Status Monitor 2

Status Monitor 2 lets you view detailed information about your 
print jobs and control how you want printing monitored. 

There are three ways to access Status Monitor 2:

◗ Click Start, point to Programs, click the Epson folder, 
and click EPSON Status Monitor 2.

◗ Double-click the  icon (when background monitoring 
is enabled) on the taskbar in the bottom right corner of 
your screen.

◗ Access the printer software from your application or the 
Printers utility (see page 1-2 and page 1-4), click the Utility 
tab, and click the EPSON Status Monitor 2 icon. (This 
method accesses the Printer Status window only; see 
page 4-5 for details.)

When you start Status Monitor 2, you see the main window:

Note:
To control network traffic, 
you may need to limit the 
number of systems that 
monitor the printer.

The Status Monitor 2 icon 
appears on the taskbar only 
when background 
monitoring is enabled. See 
page 4-7 to enable 
background monitoring.

button bar

Printer icon 
and name

Brief status 
messages 
appear here

The number of 
print jobs waiting 
to print appears 
here

Printer Name, 
Status, and Job 
Count title bars

menu bar
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If you have more than one printer you want to monitor, you 
can add them using the Add Printers option in the Settings 
menu. To save your computer memory and reduce network 
traffic, you may want to delete any printers from the Status 
Monitor 2 list that you don’t need to monitor. To do this, click 
the printer in the Installed Printers list and select Delete 
Printer from the Settings menu.

The color of the Printer icon indicates the printer status as 
follows:

Other options in Status Monitor 2 let you set up monitoring 
preferences, view more details on the printer or job status, and 
enable or disable background monitoring for each printer as 
described in the next sections.

Setting Up Monitoring Preferences

You can select the way you want Status Monitor 2 to monitor 
each printer you use in the Monitoring Preferences window. 
There are several ways to open the window:

◗ Click the printer name in the Installed Printers list to 
highlight it and click the icon.

◗ Click the printer name in the Installed Printers list to 
highlight it and select Monitoring Preferences from the 
Settings menu. 

◗ Right-click the printer name in the Installed Printers list 
and select Monitoring Preferences from the drop-down 
menu.

You can customize the 
appearance of items on 
the Status Monitor 2 
main window using the 
View menu options or 
options on the button bar.

If you’re monitoring 
multiple printers, you can 
reorder them in the 
Installed Printers list by 
clicking in the Printer 
Name, Status, or Job 
Count title bar.

Icon color Status message

Green Ready to print

Yellow Paper and/or ink level is low

Red Paper and/or ink is out, paper is jammed, or a 
print or communication error has occurred

Note:
Background monitoring 
must be turned on to 
change the Background 
Monitoring and Status 
Alert preferences for 
individual printers in the 
Monitoring Preferences 
window. See page 4-7 for 
instructions.
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You see the Monitoring Preferences window:

If you turn on one or more of the Status Alert options, you’ll see 
the Status Alert dialog box when the selected condition occurs. 
For example, if you turn on Show when errors occur, the 
dialog box will appear only if a printing error occurs. If you 
select all the options, the dialog box will appear whenever you 
print, encounter an error, or have low ink levels. 

The color of the printer icon in the Status Alert dialog box 
indicates the type of error, as described on page 4-3. 

Set the length of the 
interval in which you want 
Status Monitor 2 to 
monitor your printer here
(short intervals may cause 
some applications to run 
slowly)

Turn background monitoring 
on or off for the selected 
printer here

Select if and when to 
use the Status Alert 
dialog box: while 
printing, when errors 
occur, and/or when ink 
is low

Click here to close the 
Status Alert dialog box

Click the printer name to 
highlight it, then click 
Details to open the 
Printer Status window; 
see page 4-5 for more 
information
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Using the Printer Status Window

For more details on the status of your printer, you can use the 
Printer Status window. There are several ways to open the 
window:

◗ Double-click the printer name in the Installed Printers list.

◗ Click the printer name in the Installed Printers list to 
highlight it and click the icon or select Printer Status 
from the Printer menu.

◗ Right-click the printer name in the Installed Printers list 
and select Printer Status from the drop-down menu.

◗ If you’re currently using the printer software, click the 
Utility tab, then click the EPSON Status Monitor 2 icon. 
(For instructions on accessing your printer software, see 
page 1-2 and page 1-4.)

◗ You can also access the Printer Status window by clicking 
the Details button on the Progress Meter (see page 1-5) or 
the Status Alert dialog box (see page 4-4).

You see the Printer Status window. The Current Status tab 
gives printing status and error correction information. 

Printer status 
messages appear here

If an error occurs, 
troubleshooting tips 
appear here

Illustrations of what to do if 
an error occurs appear here

If your printer runs out of 
ink, this button becomes 
active and the screen 
displays cartridge 
replacement steps on the 
right and illustrations in the 
printer graphic area
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To check the amount of ink you have, click the Consumables 
tab.

To view information about your printer’s network connections 
and other printer resources, click the Printer Information tab.

Using the Job Status Window

Use the Job Status window to view detailed information on the 
print jobs waiting to print. There are several ways to open the 
window:

◗ Click the printer name in the Installed Printers list to 
highlight it and click the icon or select Job Status 
from the Printer menu.

◗ Right-click the printer name in the Installed Printers list 
and select Job Status from the drop-down menu.

You see the Job Status window:

These graphics indicate the 
amount of ink remaining in 
your cartridges 

Note:
The Job Status window 
is very similar to the 
Spool Manager window 
(Windows 98 and 
Windows 95). Both allow 
you to pause, cancel, and 
restart print jobs. See 
page 4-11 for information 
on Spool Manager.

Jobs currently printing or waiting appear here 

menu bar
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Options in the Printer menu let you pause printing or purge all 
waiting print jobs, select or deselect the printer as your 
Windows default, and access the printer software to change 
default settings.

The Document menu options let you pause or cancel printing 
of individual print jobs. First click the print job you want to 
pause or cancel in the Document Name list to highlight it.

Enabling or Disabling Background Monitoring

You can enable background monitoring for your printer if you 
want Status Monitor 2 to alert you to any error conditions 
while you’re working on other tasks. This lets you find out if 
paper runs out or if any other printing problem has occurred 
without opening Status Monitor 2. If you have trouble with 
network traffic, you can disable background monitoring.

To turn on or turn off background monitoring, follow these 
steps:

1. Open Status Monitor 2 using one of these methods:

◗ Click Start, point to Programs, click the Epson 
folder, and click EPSON Status Monitor 2.

◗ Double-click the  icon on the Windows Taskbar in 
the bottom right corner of your screen (when 
background monitoring is enabled).

2. Click the name of the printer you want to background 
monitor (or stop monitoring) in the Printer Name list. The 
printer name is highlighted.

3. Open the Settings menu and select Background 
Monitoring.
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4. Select Monitor from restart (to begin background 
monitoring on the printer after your next system restart), 
Monitor now (to begin background monitoring right 
away), or Stop monitoring now (to stop background 
monitoring).

5. Now set your monitoring preferences for the printer as 
described on page 4-3.

Changing Status Monitor 2 Settings

You can run through the Setup program and change your 
settings without uninstalling and reinstalling Status Monitor 2. 
This procedure allows you to change any of the following 
settings:

◗ Number of hops

◗ Types of printers you can monitor

◗ EPSON TCP/IP printing

You can also run this program any time you install the printer 
software and Status Monitor 2 is unable to find the printer.

Follow these steps to change your settings:

1. In Windows Explorer or My Computer, find the folder 
where your EPSON Status Monitor 2 files are located 
(ESM2 is the default) and double-click Setup.exe.

2. Close any open programs and click Next.

3. If you are using Windows 98 or Windows 95 and you have 
TCP/IP installed, you see a screen asking you if you want to 
enable EPSON TCP/IP printing. Select Yes if you want to 
print with TCP/IP, and then click Next. If you are printing 
with Novell NetWare, select No. 

TCP/IP Printing:     Yes_______     No_______

Note:
You may not see screens 
for all the steps here, 
depending on your 
computer’s configuration.

Write down your settings 
in the spaces provided. 
You can refer to them if 
multiple systems are 
monitoring the printer.
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4. Select the type of printer(s) you want to monitor and click 
Next. 

Monitor:      
EPSON TCP/IP printers_______  LPR printers _______
NetWare printers_______ local printers_______ 

5. Select Monitor to monitor EPSON network printers that 
do not have drivers on your computer. Select Do not 
monitor if network traffic is a problem. Then click Next.

Printers:  Monitor_______   Do not monitor_______

6. If you’re using NetWare, set the number of hops (0 to 15) 
and click Next. 

Number of hops:   _______

7. Check the current settings and click Next. Select Yes and 
click Finish to restart your computer.

Selecting the Speed & Progress Options 
(Windows 98 and Windows 95)

You can set up the way your printer software sends print jobs 
and select whether to display the Progress Meter using the 
Speed and Progress dialog box. To access the dialog box, 
open your printer software as described below.

1. Click Start, point to Settings, then click Printers.

2. Right-click the EPSON Stylus COLOR 850 printer icon 
and select Properties from the drop-down menu. You see 
the printer settings dialog box.

Caution:
If you have dial-up routers 
in a NetWare 
environment, they may 
automatically dial up the 
next hop and you may be 
charged for the line 
connection depending on 
the number of hops you 
set. To prevent this and to 
keep network traffic to a 
minimum, ask your 
network administrator 
before you change this 
setting. 
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3. Click the Utility tab. You see the Utility menu:

4. Click the Speed & Progress button. 

You see this dialog box:

Speed & Progress 
button

If you have more than 
one hard drive, you can 
select a folder for storing 
multiple copy print jobs 
here. You don’t see this 
box if you have only one 
hard drive.
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Select the following options:

◗ High Speed Copies speeds up printing of multiple 
copies of the same document by using your hard drive 
space as a cache.

◗ Show Progress Meter lets you control whether or 
not the Progress Meter is displayed when you send a 
print job. See page 1-5 for information on the Progress 
Meter.

◗ EPSON Printer Port lets you optimize the transfer rate 
of your printer port for EPSON printers instead of 
using the Windows default printer port. If you are 
printing over the network, ignore this option; it is for 
printing locally.

5. Click OK to close the Speed & Progress dialog box and 
return to the Utility menu. Then click OK again to exit 
your printer software.

Using the Spool Manager (Windows 98 and 
Windows 95)

The Spool Manager creates a temporary print job file and stores 
it in the C:\TEMP or C:\WINDOWS\TEMP folder. The 
software then sends the file to your printer at the right time.

To open Spool Manager while you’re printing, click the 
EPSON Stylus COLOR 850 icon that appears on the taskbar at 
the bottom of the screen.
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You see the Spool Manager window:

The Spool Manager window displays the status of your print 
job files and lets you control them. To cancel, pause, resume, or 
restart a print job, click the job to highlight it; then click one of 
the command buttons on the bottom of the window. 

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it and continue printing:

1. Click the EPSON Stylus COLOR 850 icon on the taskbar.

2. Click on any print jobs marked Held. 

3. Click the Cancel button. 

4. Exit Spool Manager and try printing again.

Additional Monitoring Options in 
Windows NT 4.0

Windows NT 4.0 servers and workstations include a messenger 
service to alert you to printer errors or let you know when a 
print job is finished. If you have appropriate network access 
privileges or you’re controlling printing from the server, you 
can also cancel, pause, or restart print jobs and set the sharing, 
security, scheduling, and port options. 

print job file command buttons

Note:
See your Windows NT 
documentation for more 
information on monitoring 
options.
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Managing Print Jobs in 
Windows 3.1
Your Windows printer software includes two management 
utilities: the Spool Manager and Despooler. 

◗ The Spool Manager starts automatically when you send a 
job to the printer. It allows you to print in the background 
while you continue to work on your computer and to hold 
jobs to print at a later time. It also handles multiple print 
jobs that come in from different computers on the network 
at the same time. See the next section for details.

◗ The Despooler also starts automatically when you send a 
job to the printer. It displays on your screen to alert you 
about printer status. See page 1-6 for more information on 
the Despooler. 

Using the Spool Manager

The Spool Manager works like the Windows Print Manager. 
When you send a job to your printer, your printer software 
creates a temporary print job file, stores it in the C:\TEMP or 
C:\WINDOWS\TEMP directory, and assigns it to a print 
queue. The software then sends the file to your printer at the 
right time.

To open Spool Manager, do one of the following:

◗ To open it while you’re printing, click the EPSON Spool 
Manager icon at the bottom of your desktop. 

◗ You can open Spool Manager at any time by 
double-clicking the Spool Manager4 icon in the EPSON 
program group.

Note:
You may not see the 
Spool Manager icon if 
Program Manager or the 
current window is 
maximized. Reduce the 
window size to see the 
Spool Manager icon.
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You see the Spool Manager window:

The Spool Manager window displays the status of your print 
job files and lets you control them. You can also control print 
queues, display of the Despooler, and the default spool 
directory. Click Help in the Spool Manager menu bar for 
detailed information.

Deleting a Stalled Print Job

If you’re having trouble printing, it may be because of a stalled 
print job. Follow these steps to delete it and continue printing:

1. Open the Spool Manager as described on page 4-13.

2. Click on any print jobs marked Held. 

3. Open the Document menu and click Delete. Then 
click Yes.

4. Exit Spool Manager and try printing again.

Changing the Default Spool Directory

If you get an error message while printing, or printing is very 
slow, you can try changing your default spool directory.

1. Make a directory on your hard drive where you want 
Spool Manager to store print job files, for example, 
C:\SPLTEMP.

queue print job file
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2. Open the Spool Manager as described on page 4-13.

3. Make sure EPSON Stylus COLOR 850 is selected, and 
then choose Setup from the Queue menu. The Queue 
Setup dialog box appears.

4. Change the spool directory to the one you created in step 1. 

5. Make sure Use Print Manager for this port is checked. 
Then click OK. 

6. Choose Default Spool Directory from the Options menu. 

7. In the dialog box, change the spool directory to the one you 
created in step 1. Then click OK.

8. Close Spool Manager.

Managing Print Jobs on a 
Macintosh
Your Macintosh printer software includes two print job 
management utilities: Monitor3 and Status Monitor. It also 
includes a Configuration utility for setting up print monitoring 
options.

◗ If you’re using background printing, Monitor3 starts 
automatically when you send a job to the printer. It handles 
printing while you continue to work on your Macintosh, 
lets you track documents that are waiting to be printed, and 
lets you set printing priorities for waiting print jobs.

◗ The Status Monitor alerts you to any problems that occur 
during printing. You can also use it at any time to see how 
much ink you have left. 

◗ The Configuration utility lets you select how you want to 
be notified of printer errors and where you want print job 
files stored.
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Using Monitor3

The Monitor3 utility lets you continue to work on your 
Macintosh while your document is printing (however, 
background printing is slower and may also slow down your 
system). You can then open the Monitor3 dialog box to check 
on your print jobs and cancel, pause, or restart them.

To use this utility, you need to turn on background printing 
and increase the memory allocation for Monitor3, as described 
in the next section.

Setting Up Monitor3

1. Open the Chooser from the Apple menu and select the 
SC 850(AT) icon. Then select the port or AppleTalk zone 
you’re using.

2. Under Background Printing, click On and close the 
Chooser.

3. To increase the memory allocation, select EPSON 
Monitor3 from the Extensions folder in your System 
folder. Then choose Get Info from the File menu and set 
the Memory Requirements to 2000 or 3000, depending 
on your system’s available RAM.
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Monitoring Print Jobs with Monitor3

While you’re printing, click the EPSON Monitor3 icon on the 
Application menu at the right end of the menu bar. You see the 
following dialog box:

You can track the printer’s progress with the current job and 
select a job that is currently printing or waiting to print and 
cancel, pause, or restart it. 

To set priorities for a job waiting to print, click the job, then 
click the Show details arrow at the bottom of the window. 
The Priority list becomes active. Click the arrow and select 
Normal, Urgent, or Hold. The job moves up or down in the 
list of waiting print jobs.

Using the Macintosh Status Monitor

You can use the Status Monitor to check the level of ink in your 
printer. Follow these steps:

1. Choose Page Setup or Print from the File menu in your 
application. You see a printer settings dialog box.

Job currently 
printing

Jobs queued 
for printing

Click to set 
priorities for 
waiting print 
jobs

Note:
If you see a stop sign 
icon and the message 
“Print queue on hold” in 
the EPSON Monitor3 
dialog box, select Start 
print queue from the 
Printer menu to release 
the queue and resume 
printing.
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2. Click the Utility button. You see the Utility menu:

3. Click the EPSON StatusMonitor icon. The software 
checks the amount of ink remaining in the printer and 
displays the Status Monitor window:

4. To update the ink level check, click the Update button. To 
close the Status Monitor dialog box, click OK.

For information 
about these 
utilities, see 
Chapter 5

Click the EPSON 
StatusMonitor 
icon

Click to recheck 
the ink level
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Selecting Configuration Options

You can configure the way you want the printer to handle error 
messages, warnings, ink level checks, and temporary spool 
folders in the Configuration Settings dialog box. Follow these 
steps:

1. Choose Page Setup or Print from the File menu in your 
application. You see a printer settings dialog box.

2. Click the Utility button. You see the Utility menu.

3. Click the Configuration button. You see the 
Configuration Settings dialog box:

4. Select the configuration options you want:

◗ Error notification lets you select whether you want 
your system to beep and display error message text or 
just display text if your printer encounters an error.

◗ Warning lets you choose whether warning messages 
beep and display text or display text only.

Printing stops when these 
messages appear

Printing continues when 
these messages appear

Spooled print job files are 
stored in these folders

Click here to check for 
errors and/or ink levels 
before printing

Click here to select the 
default configuration settings
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◗ Temporary Spool folder and Temporary High 
Speed Copies folder let you select the folders on your 
hard disk that store the temporary print job and high 
speed multiple-copy print job files created when you 
send a job to the printer. Click the Select button to 
change the folder from the default folder shown.

◗ Click the Check for errors before starting to print 
checkbox if you want your software to check for errors 
before starting your print job.

◗ Click the Check the ink level before starting to 
print checkbox if you want your software to check for a 
low ink condition before starting your print job.

5. When you’re finishing changing your configuration 
options, click OK to return to the Utility menu.
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It’s easy to keep your EPSON Stylus COLOR 850Ne printer 
working at its best. Just follow the simple instructions in this 
chapter for replacing ink cartridges, performing routine 
maintenance, and moving the printer in these sections: 

◗ Replacing an ink cartridge

◗ Cleaning the print heads

◗ Aligning the print heads

◗ Cleaning the printer

◗ Transporting the printer

Replacing an Ink Cartridge
When a 

 

B black or 

 

A color ink out light flashes, the indicated 
cartridge is low on ink. This is a good time to make sure you 
have a new cartridge. When the light stays on, the cartridge is 
empty and you need to replace it.

Use these EPSON ink cartridges within six months of installing 
them and before the expiration date on the package: 

Black ink cartridge S020108 
Color ink cartridge S020089 

When you need new ink cartridges, contact your dealer or call 
EPSON Accessories at (800) 873-7766 (U.S. only). In Canada, 
please call (800) 873-7766 for dealer referral. Or visit our 
website at www.epsonsupplies.com (U.S. sales only).

Maintenance and
Transportation

Warn other users on your 
network that the printer 
will be unavailable when 
you perform maintenance 
on it, or any time you 
disconnect it from the 
network.

Caution:
To ensure good results, 
use genuine EPSON 
cartridges and do not 
refill them. Other 
products may cause 
damage to your printer 
not covered by EPSON’s 
warranty.
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When the 

 

A color ink out light comes on, you can continue to 
print with black ink. Simply turn the printer off and then back 
on again. When you print, make sure you choose Black as the 
Ink setting in your printer software. 

Removing an Empty Ink Cartridge

You can replace a cartridge when the 

 

B black or 

 

A color ink 
out light is either flashing or on. Determine which ink cartridge 
needs to be replaced, then follow these steps:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover. Then 
locate the 

 

Y black and 

 

X color cleaning buttons next to the 
control panel under the printer’s cover.

3. Press the 

 

Y black or 

 

X color cleaning button and hold it for 
three seconds. 

The print heads move slightly left and the 

 

Ppower light 
begins flashing. (The print heads return to their home 
position if you don’t proceed to step 4 within 60 seconds.)

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.

black cleaning 
button

color cleaning 
buttonCaution:

If you press a cleaning 
button when its 
corresponding ink out 
light is off or not flashing, 
the printer cleans the 
print heads, as described 
on page 5-6. If you need 
to replace an ink cartridge 
before the lights flash 
(because the ink is too 
old, for example) follow 
the instructions on 
page 5-5.
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4. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder. (Although the illustration shows the black ink 
cartridge, the procedure is the same for replacing the color 
ink cartridge.)

5. Lift the cartridge out of the printer and dispose of it 
carefully. 

Follow the steps in the next section to install the new ink 
cartridge.

Caution:
Don’t open the clamp or 
remove a cartridge 
except to replace it with 
a new one. Once you 
remove a cartridge, you 
can’t reuse it, even if it 
contains ink.

Warning:
If ink gets on your hands, 
wash them thoroughly with 
soap and water. If ink gets 
into your eyes, flush them 
immediately with water.
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Installing the New Cartridge

Once you have removed the empty cartridge, you’re ready to 
install the new one. Follow these steps:

1. Remove the new ink cartridge from its packaging. 

2. Remove only the yellow part of the tape seal on top as 
shown below. Don’t pull off the white portion or try to 
remove the clear seal underneath the cartridge.

3. Lower the ink cartridge into its holder with the label facing 
up and the arrow pointing to the back of the printer.

4. Press down the ink cartridge clamp until it locks in place.

Caution:
You must remove the 
yellow tape from the top 
of the cartridge or you 
will permanently damage 
it. It’s okay if the tape 
doesn’t tear off 
completely at the dotted 
line. Do not remove the 
clear seal from the 
bottom of the cartridge; 
ink will leak out.

black cartridge color cartridge
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5. If you need to replace the other ink cartridge, follow the 
steps under “Removing an Empty Ink Cartridge,” and then 
steps 1 through 4 under “Installing the New Cartridge.”

6. Press the 

 

E load/eject button and close the printer cover. 

The printer moves the print heads and begins charging the 
ink delivery system. (Even if you don’t press the button, ink 
charging begins 60 seconds after you close the clamp.)

The 

 

Ppower light flashes, and the printer makes various 
sounds. Charging takes about three minutes. When it’s 
finished, you can print again.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. How can you tell? You may notice that your 
printouts don’t look as good as they used to. If print quality 
doesn’t improve after cleaning and aligning the print heads, you 
can replace one or both cartridges.

Follow these steps to replace an ink cartridge before the 

 

B black 
or 

 

A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing.

2. Lower the output tray and raise the printer cover.

3. Press both the 

 

Y black and 

 

X color cleaning buttons and 
hold them down for a few seconds until the black print 
head moves to the left.

◗ To replace the black ink cartridge, follow the 
instructions beginning with step 5 on page 5-3. 

◗ To replace the color ink cartridge, press the 

 

X color 
cleaning button and hold it down for a few seconds. 
After the color ink cartridge moves to the left, follow 
the instructions beginning with step 5 on page 5-3.

Caution:
Never turn off the printer 
while the Ppower light is 
flashing, unless the printer 
hasn’t moved or made any 
noise for more than 10 
minutes.

Caution:
To avoid damaging the 
printer, never move the 
print heads by hand.
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Cleaning the Print Heads 
If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print heads. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print heads uses ink, so clean them only if print 
quality declines. You can clean the print heads in either of the 
following ways:

◗ With the Head Cleaning utility in your printer software 
(when Status Monitor 2 is installed)

◗ From the printer’s control panel buttons

Using the Head Cleaning Utility

Follow these steps to run the utility from a Windows computer 
or a Macintosh:

1. Make sure the printer is turned on but not printing, and 
the 

 

B black and 

 

A color ink out lights are off.

2. Access the printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Head Cleaning button.

5. Follow the instructions on the screen to clean one or 
both print heads. Cleaning both heads takes about four 
minutes, during which the printer makes some noise and 
the 

 

Ppower light flashes. 

When the power light stops flashing, you need to run a 
nozzle check to test the print quality and reset the cleaning 
cycle.

Caution:
Never turn off the printer 
while the Ppower light is 
flashing, unless the printer 
hasn’t moved or made any 
noise for more than 10 
minutes.
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6. Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh). Then click Next. See page 5-8 for 
instructions on examining the nozzle check pattern.

If your print quality has not improved, repeat the steps above. If 
you don’t notice any improvement after doing this two or three 
times, check the print quality solutions in Chapter 6.

Using the Control Panel

Follow these steps to clean the print heads:

1. Make sure the printer is turned on and not printing, and 
that the 

 

B black and 

 

A color ink out lights are off. 

2. Open the printer cover, then press the 

 

Y black or 

 

X color 
cleaning button and hold it down for three seconds. 
Cleaning takes about two minutes, during which the 
printer makes some noise and the 

 

Ppower light flashes. 

3. When the 

 

Ppower light stops flashing, repeat step 2 for the 
other print head if necessary. 

4. After you’re finished cleaning and the 

 

Ppower light stops 
flashing, you need to print a page to test the print quality 
and reset the cleaning cycle. If you’re using Status 
Monitor 2, run a nozzle check. Go to step 5.

If you’re using DOS or you didn’t install Status Monitor 2, 
open an application and print a document containing black 
and color data. Then go to step 7.

5. Access the printer settings dialog box as described in 
Chapter 1. Then click the Utility tab (Windows) or the 
Utility button (Macintosh). You see the Utility menu.

6. Click the Nozzle Check button, then click Next. See the 
next section for instructions on examining the nozzle check 
pattern.

Caution:
Never turn off the printer 
while the P power light is 
flashing, unless the printer 
hasn’t moved or made any 
noise for more than 10 
minutes.
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7. If your print quality has not improved, repeat the steps 
above. If you don’t notice any improvement after doing this 
two or three times, check the print quality solutions in 
Chapter 6.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this, with the lower pattern colored cyan, 
magenta, and yellow:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If any dots are missing, as shown 
below, clean the print heads again; see page 5-6 for instructions.

Aligning the Print Heads 
If your printouts contain misaligned vertical lines, you may 
need to align the print heads. You can align the print heads in 
either of the following two ways:

◗ With the print head alignment utility

◗ Using the printer’s control panel buttons

missing dots

Note:
If you installed Status 
Monitor 2, you can use the 
Print Head Alignment 
utility.
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Using the Print Head Alignment Utility

Follow these steps to run the utility (Windows or Macintosh):

1. Make sure the printer is turned on and paper is loaded.

2. Access the printer settings dialog box as described in 
Chapter 1.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment button.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

Using the Control Panel

Follow these steps to align the print heads:

1. Make sure the printer is turned off and paper is loaded. 
Then open the printer cover.

2. Hold down the 

 

E load/eject button and the 

 

Y black 
cleaning button and turn on the printer. Then release the 
buttons. After a moment, the printer prints an instruction 
sheet telling you how to select a language for the alignment 
instructions.

3. Press the correct control panel buttons as instructed to 
select a language. The printer prints instructions for 
aligning the print heads.

4. Follow the instructions on the sheet to align the print 
heads. When you’re finished, turn off the printer to exit the 
alignment mode.

Caution:
Load paper that’s at least 
8.27 inches (210 mm) 
wide. This prevents ink 
from spraying inside the 
printer and smudging 
your printouts.

For the best results, load 
EPSON ink jet paper in 
the printer whenever you 
check the print head 
alignment.

bunnyUG.book  Page 9  Wednesday, November 4, 1998  9:22 AM



Maintenance and Transportation

5-10

Cleaning the Printer 
To keep your printer working at its best, you should clean it 
several times a year, following these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the network cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 
Keep the printer cover closed so water doesn’t get inside.

4. Clean out the printer’s interior with a soft, damp cloth.

Transporting the Printer
If you plan to transport your printer some distance, you’ll need 
to repack it in its original box. Follow these steps:

1. Turn on the printer and wait until the print heads lock in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the network cable from the printer.

3. Remove the paper support and any paper from the printer.

4. Push in the output tray extensions and close the tray.

5. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Notice Sheet that was packed with the printer.

Be sure to keep the printer level as you transport it. If you 
notice a decline in print quality after transporting the printer, 
clean the print heads; if output is misaligned, align the print 
heads. See the instructions in this chapter.

Caution:
Don’t touch the gears 
inside the printer.

Never use alcohol or 
thinner for cleaning; they 
can damage the printer 
components and case.

Don’t use a hard or 
abrasive brush.

Don’t get water on the 
printer components.

Don’t spray lubricants or 
oils inside the printer.

Note:
If you move the printer to 
a new network, you need 
to initialize its Ethernet 
card and configure it for 
that network. (See your 
Setup Guide.)

Caution:
To avoid damage, always 
leave the ink cartridges 
installed when 
transporting the printer.
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As you use your printer, you may occasionally experience a 
paper jam or other problem. The first thing you should do is 
diagnose the problem, following the guidelines in this chapter. 
Then try the most likely solutions until the problem is fixed. 

This chapter covers the following problems and solutions:

◗ Diagnosing problems

◗ Improving print quality

◗ Solving printing problems

◗ Solving printer software problems

◗ Fixing paper jams and other paper problems

◗ Solving miscellaneous printout problems

◗ Uninstalling the software

Diagnosing Problems 
Your printer provides a number of ways to help you diagnose 
problems:

◗ To identify the most common problems, check the lights 
on the printer’s control panel. See page 6-2 for details.

◗ You can also use the Status Monitor 2 utility to identify 
common problems. For instructions, see page 4-2 
(Windows) or page 4-17 (Macintosh).

Troubleshooting

Note:
If you cannot solve the 
problem with the solutions 
in this chapter, check the 
troubleshooting chapter in 
your Administrator’s Guide 
to see if you are having 
network-related problems.
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◗ To determine whether the problem is caused by the printer 
itself, run a self test. See page 6-3 for instructions.

◗ You can use the printer’s hex dump mode to pinpoint 
communication problems. See page 6-4 for instructions.

◗ For the latest information, check the Help programs and 
the ReadMe files in the Epson program group or folder. 

◗ If any of the suggested solutions in this chapter tell you to 
uninstall and then reinstall your printer software, see 
page 6-17 for instructions.

◗ If none of the suggested solutions in this chapter solve your 
problem, contact EPSON as described under “Where to 
Get Help” in the Introduction. 

Checking the Control Panel Lights

Follow these guidelines when the control panel lights come on 
or flash:

power button

load/eject button
color cleaning 
button

black cleaning 
button

paper out light

color ink out light
black ink out light

power light

 

S When the paper light flashes, paper is jammed in the printer. 
Turn off the printer and gently pull out all the paper. Then 
press the 

 

E load/eject button. See page 6-14 for details.

 

S When the paper light comes on, your paper ran out or is 
incorrectly loaded. Load paper in the feeder and then press 
the 

 

E load/eject button. 
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Running a Self Test

You can run a self test to determine whether the problem comes 
from the printer itself or some other source. 

◗ If the results are satisfactory, the problem lies in your 
software settings, the network and configuration, or your 
computer.

◗ If the self test does not print correctly, you have a problem 
with your printer. See the suggestions in this chapter for 
possible solutions.

1. Make sure both the printer and computer are turned off.

2. Disconnect the network cable from the printer.

3. Make sure paper is loaded in the printer.

4. Hold down the 

 

E load/eject button (for a 360 dpi test) or 
the 

 

Y black cleaning button (for a 180 dpi test) and press 
the 

 

Ppower button. Hold down the buttons until the 

 

Ppower light starts to flash, then release them.

The printer prints on the first and last lines of one sheet of 
paper, then prints a nozzle check pattern (shown on 
page 5-8) and samples of fonts and colors on the next sheet. 

5. To end the test, turn off the printer. Then reconnect the 
network cable and turn on your printer and computer.

 

B A When an ink light flashes, your ink supply is low. Make sure 
you have a replacement cartridge.

 

B A When an ink light comes on, you need to replace the ink 
cartridge. See Chapter 5 for instructions.

 

P S B A When the power light and paper out light flash and all the 
other lights are on, your printer has a carriage error. See 
page 6-9 for more information.

 

P S B A When all the lights flash, your printer may have an internal 
error. See page 6-10 for more information.

Caution:
Load paper that’s at least 
8.27 inches (210 mm) 
wide. This prevents ink 
from spraying inside the 
printer and smudging 
your printouts.
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Using Hex Dump Mode

You can use the printer’s hex dump mode to identify problems 
if you know how to interpret hex code. Or, you can fax the hex 
printout to a technical support representative. Follow these 
steps:

1. Make sure the printer is turned off and has paper loaded 
in it.

2. Open the cover.

3. Hold down the 

 

E load/eject button and the 

 

X color 
cleaning button and press the 

 

Ppower button. The printer 
prints Hex Dump Mode at the top of a page and then 
stops.

4. Print one or more pages from an application as usual. The 
printer prints the exact code it receives in hexadecimal 
format.

5. Turn off the printer to exit hex dump mode.

Improving Print Quality
If you find that your print quality has been declining, you can 
often improve it by doing one or more of the following:

◗ Clean the print heads by running a cleaning cycle. Follow 
the instructions in Chapter 5.

◗ Use higher quality paper appropriate for your print job. 
(See Chapter 2 for a list of EPSON papers.)

◗ Match the Media Type in the printer software to the type 
of paper you loaded in the printer. Then the printer 
software can automatically select other settings for the best 
quality. (See Chapter 1 for details.)

◗ Turn off High Speed mode in the More Settings dialog 
box, as described in Chapter 3.
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◗ Make sure Economy mode is turned off in the printer 
software, as described in Chapter 3.

◗ Replace the ink cartridges as described in Chapter 5. 
(Check the status of the 

 

B black and 

 

A color ink out lights 
first.)

Here are some detailed solutions to specific print quality 
problems.

Printed image has horizontal banding.

Vertical lines are misaligned or vertical banding appears.

Possible cause Solution

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper you’re 
using. See Chapter 1 for instructions.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 2 for instructions.

The print head nozzles are 
clogged.

Clean the print heads by running a cleaning cycle. See Chapter 5 
for instructions.

The ink cartridges are low on 
ink.

Check the 

 

B black and 

 

A color ink out lights to see which 
cartridge you may need to replace. See Chapter 5.

The MicroWeave or Super 
MicroWeave option is not 
turned on.

Turn on MicroWeave or Super MicroWeave (if available) in the 
More Settings dialog box. See Chapter 3 for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads by running a cleaning cycle. See Chapter 5 
for instructions.

The High Speed setting is 
turned on.

Turn off the High Speed setting if vertical lines are misaligned. 
See Chapter 3 for information.

The print heads are 
misaligned.

Run the Print Head Alignment utility. See Chapter 5 for 
instructions.
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The printed image has incorrect or missing colors.

The printed image is faint or has gaps.

Possible cause Solution

The Ink option is set to 
Black.

Change the Ink setting to Color. See Chapter 1 for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper you’re 
using. See Chapter 1 for instructions.

The printable side of the 
paper is face down.

Remove the paper and reload it with the printable side face up. 
See Chapter 2 for instructions.

The Halftoning and Color 
Adjustment Mode options 
are set incorrectly for your 
document type.

Use the correct settings for the project you’re printing, following 
the instructions in Chapter 3.

The ICM (Windows 98 or 
Windows 95) or ColorSync 
(Macintosh) settings are 
incorrect for your 
document.

Use the Automatic mode setting or choose a different Rendering 
Intent setting (Macintosh). See Chapter 3 for more information.

The print head nozzles are 
clogged.

Clean the print heads. See Chapter 5 for instructions.

The ink cartridges are low 
on ink or one or more ink 
colors are empty.

Check the 

 

B black and 

 

A color ink out lights to see which 
cartridge you may need to replace. See Chapter 5 for instructions.

The colors displayed on 
your monitor don’t match 
the printed colors.

Because your monitor and printer use different technologies to 
represent colors, your printed colors can’t exactly match the 
colors you see on your monitor screen. Use the ICM (Windows 98 
or Windows 95) or ColorSync (Macintosh) settings to get as close 
a match as possible. See Chapter 3 for more information.

The color settings in your 
application software need 
adjustment.

You may be able to adjust various color settings in your application 
software. See your software documentation for more information.

Possible cause Solution

The print head nozzles are 
clogged.

Clean the print heads by running a cleaning cycle. See Chapter 5 
for instructions.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper you’re 
using. See Chapter 1 for instructions.
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The printed image is blurry or smeared.

The loaded paper is 
damaged, old, or dirty.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 2 for instructions.

The ink cartridges are low 
on ink.

Check the 

 

B black and 

 

A color ink out lights to see which 
cartridge you may need to replace. See Chapter 5 for instructions.

Possible cause Solution

The paper thickness lever is 
in the 0 position.

Set the paper thickness lever to the + position and try printing 
again. See Chapter 2 for instructions.

The paper is damp or the 
printable side is face down.

Remove the paper and reload a new stack with the printable side 
face up. See Chapter 2 for instructions.

You loaded special media 
without a support sheet.

Follow the special media loading instructions in Chapter 2 and on 
the paper packaging for media that require support sheets. Also 
try loading your media one sheet at a time.

You tried to print on 
cardboard or other 
non-recommended media.

Make sure your paper or media meets the specifications listed in 
Appendix B. If your printouts are still blurry after you change 
paper, clean the print heads as described in Chapter 5.

The Media Type setting 
doesn’t match the loaded 
paper.

Make sure the Media Type setting matches the paper you’re 
using. See Chapter 1 for instructions.

Ink has leaked inside the 
printer.

Clean carefully inside the printer to remove spilled ink. See 
Chapter 5 for instructions.

You’re using the High 
Speed and MicroWeave 
settings with a misaligned 
print head.

Turn off High Speed following the instructions in Chapter 3. Run 
the Print Head Alignment utility following the instructions in 
Chapter 5.

The resolution of your 
image is too low.

If a photographic image looks grainy or rough, try using the 
PhotoEnhance 2 (PhotoEnhance on Windows 3.1) setting to 
improve the printed quality. See Chapter 3 for details.

Increase the image resolution using your image editing software, 
or decrease the size of the image.

Possible cause Solution
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Solving Printing Problems
If the printer won’t print, first check that:

◗ The printer is turned on and the 

 

Ppower light is on.

◗ Paper is loaded in the printer.

◗ The printer is plugged into a working electrical outlet that’s 
not controlled by a switch or timer.

◗ The network cable is securely connected to the printer and 
the hub, and any relevant network cables are securely 
connected. 

If you still can’t print, check the following solutions.

All lights are off.

Only the 

 

Ppower light is on, but nothing prints.

Possible cause Solution

The printer is not receiving 
power.

Try these solutions:
◗ Make sure the printer is turned on.
◗ Turn off the power and plug in the power cord securely.
◗ Make sure the outlet is not controlled by a switch or timer and
   is operable.

Possible cause Solution

The interface cable is not 
connected securely.

Turn off your printer and computer. Then make sure the cable is 
connected securely and meets the printer’s specifications.

The printer has an internal 
problem.

Turn off the printer and computer, disconnect the interface cable, 
and run a self test as described on page 6-3.

The printer or application 
software is installed 
incorrectly.

If the self test works, check your printer, network, and application 
software for correct installation. 

Your computer doesn’t have 
enough memory to handle 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or
   monitor.
◗ Add more memory to your computer.
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The 

 

S paper out light is flashing or on.

A 

 

B black or 

 

A color ink out light is flashing or on.

The 

 

S and 

 

Plights are flashing.

Printing is stalled. In Windows 98/95/3.1x, delete the stalled print jobs in Spool 
Manager; see Chapter 4 for instructions. In Windows NT, use the 
spooler.

On a Macintosh, delete stalled print jobs using Monitor3 or open 
the Extensions folder, EPSON folder, and Spool folder; then 
delete any queued files.

The print heads are clogged 
or the ink cartridges are too 
old.

Clean the print heads by running a cleaning cycle; see Chapter 5 
for instructions. If cleaning doesn’t help, replace the cartridges. 
For information on cartridge life and replacement instructions, see 
Chapter 5.

Possible cause Solution

If flashing, paper is jammed. Remove the paper and follow the guidelines for preventing jams 
as described on page 6-14.

If on, paper is used up or is 
loaded incorrectly.

Load paper or remove the stack and reload it as described in the 
Setup Guide and in Chapter 2. Then press the 

 

E load/eject button 
to turn off the light and resume printing.

Possible cause Solution

If flashing, the ink supply is 
getting low.

You need to replace the indicated ink cartridge soon; see 
Chapter 5 for instructions.

If on, the ink cartridge is 
empty.

You must replace the indicated ink cartridge now to be able to 
print; see Chapter 5 for instructions.

Possible cause Solution

A carriage error has 
occurred.

Remove any paper in the printer. Press the 

 

E load/eject button for 
about 30 seconds. Then press it again. Turn the printer off, wait a 
few seconds, and then turn it on and try printing again. If the error 
is not cleared, contact EPSON as described in the Introduction.

Possible cause Solution
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All the lights are flashing.

The printer has finished charging the ink cartridge, but the 

 

P power light is 

still flashing.

Solving Printer Software Problems
If you have trouble with your printer software, first check that 
your printer is selected as the default Windows printer or as the 
current printer in the Macintosh Chooser; see the Setup Guide 
for instructions.

If you still have problems with your printer software, check the 
following solutions.

Possible cause Solution

You haven’t removed all the 
packing material from the 
printer.

Remove the packing material, following the instructions on the 
Notice Sheet in the box. 

An internal error may have 
occurred.

Turn off your printer, wait a few seconds, and turn it on again. If 
the lights still flash or stay on, contact EPSON as described in the 
Introduction.

Possible cause Solution

The ink cartridge clamp 
isn’t locked down.

Press down on the clamp to lock it.

Packing material remains in 
the printer.

Remove all packing material, following the instructions on the 
Notice Sheet in the box.

The printer needs to 
initialize.

If the printer is not moving or making noise, but the light is still 
flashing for more than 10 minutes, turn the printer off. If the light is 
still flashing when you turn it back on, contact EPSON as described 
in the Introduction.
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The printer software installed with Windows 3.1 doesn’t work correctly 

after you upgrade to Windows 98 or Windows 95. 

After you install your printer software, you see the Windows 95 or 

Windows 98 New Hardware Found window.

You see a spooling error message (Windows).

You see a memory error message (Macintosh).

Possible cause Solution

Your printer software is not 
set up correctly for 
Windows 98 or 
Windows 95.

After installing Windows 98 or Windows 95, uninstall the printer 
software as described on page 6-17, then reinstall the printer 
software, as described in the Setup Guide.

Possible cause Solution

An operating system error 
has occurred.

Click Do not install a driver, and then click OK. Never select any 

other option on the New Hardware Found window.

Possible cause Solution

If you see error messages 
or printing is very slow, the 
problem may be caused by 
temporary files (Windows 
3.1 only).

Change the Spool Manager default directory (Windows 3.1 only), 
following the instructions in Chapter 4.

Your hard drive is too full. Delete unnecessary files to make room on the drive.

Your computer doesn’t 
have enough memory for 
the file you’re printing.

Try one of the following:
◗ Reduce the resolution of your image.
◗ Select fewer colors or a lower resolution for your display or
   monitor.
◗ Add more memory to your computer.

Possible cause Solution

You need to increase the 
memory allocation for your 
application, EPSON 
Monitor3, or both.

Choose Get Info from the File menu when the application is active 
or EPSON Monitor3 is selected and increase the memory 
requirements. See Chapter 4 for more information. If that doesn’t 
work, turn off background printing if it’s on (you won’t be able to 
use Monitor3).

bunnyUG.book  Page 11  Wednesday, November 4, 1998  9:22 AM



Troubleshooting

6-12

In Windows 98 or Windows 95, the Status Monitor 2 window doesn’t 

appear.

Printing is too slow.

Possible cause Solution

You may not have restarted 
your computer after 
installing Status Monitor 2.

Click Start, select Shut Down, click Restart the computer, and 
click Yes to restart your computer. Then try using Status 
Monitor 2. 

You don’t have both parts of 
Status Monitor 2 installed.

Status Monitor 2 comes in two parts: one that finds the printer on 
the network, and the other that recognizes your specific printer. 
Uninstall Status Monitor 2 (as described on page 6-17) and 
reinstall it as described in the Setup Guide.

You’re using ScanDisk. Before using ScanDisk, turn off background monitoring in Status 
Monitor 2. (See page 4-7 for instructions.) Then turn it back on 
when you’re finished using ScanDisk.

The printer isn’t in the list of 
monitored printers.

Make sure your printer has been added to the monitored printers 
list in Status Monitor 2. See page 4-2 for more information.

Possible cause Solution

Your printer software 
options are set incorrectly.

For the fastest printing, try the following:
◗ Set Print Quality to Economy.
◗ Turn MicroWeave off.
◗ Turn High Speed on.
◗ Choose Black ink.
◗ Choose No Halftoning.
See Chapters 1 and 3 for more information.

Your system doesn’t have 
enough resources.

To free up resources, try the following:
◗ Clear space on your hard disk or run a defragmentation utility.
◗ Don’t run too many applications at the same time.
◗ Turn off virtual memory.
◗ Increase your system’s memory (RAM)
◗ Upgrade your CPU.

You’re using background 
printing on a Macintosh.

Select EPSON Monitor3 and choose Get Info from the File menu 
to increase the Memory Requirements for EPSON Monitor3. See 
Chapter 4 for more information. If that doesn’t work, turn off 
background printing (you won’t be able to use Monitor3).
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Your printer icon doesn’t appear in the Chooser (Macintosh).

The “SC 850AT cannot be used” message appears (Macintosh).

Fixing Paper Problems
To avoid most paper handling problems, do the following:

◗ Use smooth, high-quality media designed for ink jet 
printers that meets the media specifications in Appendix C.

◗ Follow all loading and handling instructions included with 
the media.

◗ Load the media with the printable side face up as described 
in the Setup Guide and in Chapter 2.

If you have any paper problems, check here for solutions.

Possible cause Solution

Your Macintosh has 
extension conflicts. See 
also “Solving Network 
Problems” on page 7-1 of 
your Administrator’s Guide.

Disable Quick Draw GX in the Extensions Manager. Make sure 
EPSON Monitor3 and SC 850AT are enabled, and then restart your 
Macintosh.

Possible cause Solutions

The printer software has 
been corrupted.

Remove and reinstall the printer software as described on 
page 6-18. Then, in the Extensions Manager, disable Quick Draw 
GX, enable EPSON Monitor3 and SC 850AT, and restart your 
Macintosh.
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Paper doesn’t feed.

Multiple pages feed at the same time.

Paper jams inside the printer.

Try this Then do this

Remove the stack of paper 
from the printer.

Check that the paper isn’t:
◗ Curled or creased.
◗ Too old. (See Chapter 2 or your paper packaging for more
   information.)
◗ Loaded above the arrow on the left edge guide.
◗ Jammed inside the printer. (If the 

 

S paper out light is flashing,
   paper is jammed.)
Then reload the paper as described in the Setup Guide and in 
Chapter 2, making sure the left edge guide is adjusted to fit the 
paper’s width.

Try this Then do this

Remove the stack of paper 
from the printer.

◗ Make sure the paper isn’t too thin (see the paper specifications
   in Appendix B).
◗ Fan the edges of the stack of paper to separate the sheets.
◗ Reload the paper as described in the Setup Guide and in
  Chapter 2.
◗ If too many copies of a page or document are printing, check the
   Copies settings in both the printer software and your
   application program. See Chapter 1 for more information.

Try this Then do this

Turn off your printer, open 
the cover, and remove all 
the paper that’s inside, 
including any little pieces 
that may have torn off. 

Load more paper in the printer, following the instructions in the 
Setup Guide and in Chapter 2. If your paper jams frequently, make 
sure you:
◗ Use smooth, high-quality paper, loaded printable side up.
◗ Fan the stack and then even the edges before loading it.
◗ Load paper beneath the arrow mark on the left edge guide.
◗ Adjust the left edge guide to fit the width of your paper.
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Paper doesn't eject fully or is wrinkled.

Solving Miscellaneous Printout 
Problems
If your printout results are not what you expected, try these 
solutions.

Characters are incorrect or garbled.

Possible cause Solution

If the paper doesn’t eject 
fully, you may have set the 
wrong paper size.

Press the 

 

E load/eject button to eject the paper. Then make sure 
you select the correct paper size in your printer software. See 
Chapter 3 for instructions.

If it’s wrinkled when it 
comes out, the paper may 
be damp or too thin.

See the paper specifications in Appendix B for ranges of paper 
thicknesses you can print with, as well as environmental 
requirements for storage.

Possible cause Solution

Your printer is not selected 
in your application or as the 
Windows default printer.

Select your printer in your application or select it as the default 
Windows printer. See your Windows documentation or online 
help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Select your printer in the Chooser as described in the Setup 
Guide.

Printing is stalled. In Windows, delete the stalled print jobs in Spool Manager (in the 
spooler for Windows NT). On a Macintosh, select the stalled print 
jobs in Monitor3, or open the Extensions folder, EPSON folder, 
and Spool folder; then delete any queued files. See Chapter 4 for 
instructions. 

The network cable is not 
securely connected.

Turn off your printer and computer. Then make sure the network 
cable is connected securely and meets the Ethernet card’s 
specifications.

Your video driver may be 
conflicting with the EPSON 
printer driver.

Change to a standard VGA driver (see your computer or video 
card documentation for instructions). If your printout is correct, 
your video driver is interfering with the printer driver. Contact 
your computer or video card manufacturer for an updated driver.
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The image is inverted as if viewed in a mirror.

The image size or position is incorrect.

The margins are incorrect.

A portion of your image doesn’t print (Macintosh).

Possible cause Solution

You used a Flip Horizontal 
option.

Turn off the Flip Horizontal or mirror setting in your application 
software or the printer software. See Chapter 3 for instructions.

Possible cause Solution

The paper and/or layout 
options are set incorrectly.

Check the paper settings and the settings on the Layout dialog 
box (not available in Windows 3.1x). See Chapter 3 for 
instructions. Also check the paper and layout options in your 
application software.

Possible cause Solution

Margins are set incorrectly in 
your application software.

Check your software documentation for instructions on selecting 
the correct margins for your paper size. Make sure the margins 
are within the printable area of the page. See Appendix B for 
printable area specifications.

Paper settings in the printer 
software are incorrect for 
your paper size.

Check the settings in the paper dialog box to make sure they’re 
correct for your paper size. See Chapter 3 for more information.

Possible cause Solution

Your system doesn’t have 
enough available memory.

Close any other applications you are running and turn off 
background printing.

You need to increase the 
memory allocation for your 
application, EPSON 
Monitor3, or both.

Choose Get Info from the File menu when the application is active 
and increase the memory requirements. See Chapter 4 for more 
information.
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The printer prints blank pages.

Uninstalling Printer Software
If any of the suggested solutions in this chapter tell you to 
uninstall and then reinstall your printer driver or Status 
Monitor 2, follow the steps in this section. To uninstall 
EPSON Net!2, see your Administrator’s Guide.

Windows 98, Windows 95, and Windows NT 4.0

1. Double-click the My Computer icon, then double-click 
the Control Panel icon.

2. Double-click Add/Remove Programs.

3. To uninstall your printer driver (Windows 98 and 
Windows 95 only), select EPSON Printer Software in the 
program list.

To uninstall Status Monitor 2, select EPSON Status 
Monitor 2 in the program list.

4. Click the Add/Remove button. Follow the instructions on 
the screen to uninstall your software.

5. To reinstall your software, see the Setup Guide.

Possible cause Solution

Your printer is not selected 
in your application or as the 
Windows default printer.

Select your printer as the default Windows printer. See your 
Windows documentation or online help for instructions.

Your printer is not selected 
in the Macintosh Chooser.

Select your printer in the Chooser as described in the Setup 
Guide.

Paper settings in the printer 
software are incorrect for 
your paper size.

Check the settings in the paper dialog box to make sure they’re 
correct for your paper size. See Chapter 3 for more information.

The print head nozzles are 
clogged.

Clean the print heads by running a cleaning cycle following the 
instructions in Chapter 5.

Note:
In Windows NT 4.0, you 
can’t uninstall the printer 
software with the 
Add/Remove Programs 
utility. See your 
Windows NT 
documentation to remove 
printer drivers from your 
system.

bunnyUG.book  Page 17  Wednesday, November 4, 1998  9:22 AM



Troubleshooting

6-18

Windows 3.1 Printer Software Instructions

1. Double-click the Main program group icon, then 
double-click the Control Panel icon.

2. Double-click Printers.

3. Select EPSON Stylus COLOR 850 in the Installed Printers 
list and click the Remove button.

4. To reinstall your software, see the Setup Guide.

Macintosh Instructions

1. Insert the EPSON printer software CD-ROM in your 
drive.

2. Double-click the Installer icon. Then click Continue.

3. Click the arrow in the list at the top showing Easy Install, 
and select Remove from the list.

4. Click the Remove button on the bottom of the screen.

5. Follow the instructions on the screen to uninstall the 
printer software.

6. To reinstall your software, see the Setup Guide.
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A
EPSON offers a variety of accessories for your EPSON Stylus 
COLOR 850Ne printer, from replacement ink cartridges to 
special ink jet paper and other creative media.

To purchase EPSON accessories, contact your local printer 
retailer. You can also purchase ink cartridges, EPSON media, 
and manuals from EPSON Accessories at (800) 873-7766 
(U.S. sales only). In Canada, please call (800) 873-7766 for 
dealer referral. Or visit our website at www.epsonsupplies.com 
(U.S. sales only).

When you order accessories, be sure to use the part numbers 
listed in this appendix.

EPSON
Accessories

Ink cartridges

Cartridge type Part number

Black ink cartridge S020108

Color ink cartridge S020089

EPSON ink jet paper and other media

Media name Size Part number

EPSON 360 dpi Ink Jet 
Paper

Letter
A4 

S041060
S041059

EPSON High Quality Ink Jet 
Paper

Letter
A4

S041111
S041117

EPSON Photo Quality Ink 
Jet Paper

Letter
A4
Legal

S041062
S041061
S041067

EPSON Photo Quality 
Glossy Paper

Letter
A4

S041124
S041126
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EPSON Photo Quality 
Glossy Film

Letter
A4
4.1 × 5.8 (A6)

S041072
S041071
S041107

EPSON Photo Paper 4 × 6
Letter
A4
Panoramic

S041134
S041141
S041140
S041145

EPSON Photo Sticker Kit
(CD-ROM and paper)
EPSON Photo Stickers 
(refill)

4.1 × 5.8 (A6)

4.1 × 5.8 (A6)

S041144-KIT

S041144

EPSON Photo Quality Ink 
Jet Cards

4.1 × 5.8 (A6)
8 × 10

S041054
S041122

EPSON Ink Jet 
Transparencies

Letter
A4

S041064
S041063

EPSON Photo Quality Self 
Adhesive Sheets

A4 S041106

EPSON Iron-on Cool Peel 
Transfer Paper

Letter S041153/S041155

EPSON ink jet paper and other media

Media name Size Part number
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B

Printing
Printing method On-demand ink jet

Nozzle configuration 128 black nozzles (32 × 4, staggered) 
64 color nozzles × 3 (cyan, magenta, yellow)

Printable columns and 
printing speed

Technical
Specifications

Character pitch 

(characters per inch)

Printable 

columns

Printing speed

(characters per second) 

Draft Normal

10 80 533 400

12 96 640 480

15 120 800 600

17 (10 condensed) 137 912 684

20 (12 condensed) 160 1067 800

Print quality CR speed (inches per second) 

180 dpi  × 180 dpi 26.7 

360 dpi  × 360 dpi 20 

720 dpi  × 720 dpi 20 

1440 dpi  × 720 dpi 20 
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Resolution Maximum 1440 × 720 dpi

Input buffer 32KB

Print direction Bidirectional with logic seeking for text and graphics

Control code ESC/P 2™ and expanded raster graphics code
IBM X24E emulation code

Line spacing 1/6-inch (default) programmable in 1/8-inch or 1/360-inch 
increments

Paper feed speed 100 milliseconds per 1/3-inch line

Character tables 1 italic and 10 graphics character tables

Character sets 14 international character sets and 1 legal character set

Bitmap fonts ◗ EPSON Roman (proportional)
◗ EPSON Sans Serif (proportional)
◗ EPSON Courier
◗ EPSON Prestige
◗ EPSON Script

All bitmap fonts are available in 10, 12, and 15 cpi. You can select 
other font/pitch combinations using ESC/P 2 commands.

Scalable fonts ◗ EPSON Roman
◗ EPSON Sans Serif
◗ EPSON Roman T
◗ EPSON Sans Serif H

All scalable fonts are available in sizes from 8 to 32 points, in 2 point 
increments, and four styles: normal, bold, italic, and bold italic.

The printer always uses the fonts you select with your software 
application. You need to use the printer’s internal fonts only if your 
application doesn’t allow you to select fonts.
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Paper

Notes:
Since the quality of any particular brand or type of paper may be changed by the manufacturer at 
any time, EPSON cannot guarantee the use of any particular brand or type of paper. Always test 
samples of paper stock before purchasing large quantities or printing large jobs.

Poor quality paper may reduce print quality and cause paper jams and other problems. If you 
encounter problems, switch to a higher grade of paper.

Do not load curled or folded paper, envelopes, or transparencies.

Print on ink jet papers and envelopes only under these conditions:
Temperature: 59 to 77°F (15 to 25°C)
Humidity: 40 to 60% RH

Store glossy media and self adhesive sheets under these conditions:
Temperature: 59 to 86°F (15 to 30°C)
Humidity: 20 to 60% RH

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper and 
special ink jet 
papers distributed 
by EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2) 

Transparencies 
and glossy 
media

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy 
film only)

Transparencies, 
glossy paper, and 
glossy film 
distributed by 
EPSON

Glossy film and 
transparencies: 
0.0051 to 0.0059 inch 
(0.13 to 0.15 mm)
glossy paper:
0.0067 to 0.0071 inch 
(0.17 to 0.18 mm)

—

Photo Paper 4 × 6 inches (102 × 152 mm)
Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
Panoramic (8.27 × 23.4 
inches)

Photo Paper 
distributed by 
EPSON

— —

Self adhesive 
sheets and 
iron-on cool 
peel transfer 
paper 

A4 (210 × 297 mm)
Letter (8.5 × 11 inches; 
iron-on cool peel transfer 
paper only)

Self adhesive 
sheets and 
iron-on cool peel 
transfer paper 
distributed by 
EPSON

0.0079 inch (0.2 mm) 
maximum

—

Photo stickers A6 (105 × 148 mm) with 16 
frames

Photo stickers 
distributed by 
EPSON

— —
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Printable area

A The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of glossy media, the minimum 
top margin is 1.2 inches (30 mm).

BL The minimum left margin is 0.12 inch (3.0 mm).

BR The minimum right margin is:
0.35 inch (9.0 mm) for Letter and Legal
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3.0 mm) for all other paper sizes.

C The minimum bottom margin is 0.55 inch (14.0 mm).
.

A: The maximum top margin is 0.67 inch (17.0 mm).

B–L, B–R: The maximum left and right margin is 0.24 inch (6.1 mm).

C: The maximum bottom margin is 0.24 inch (6.1 mm).

A

B-L

B-R

C

A

B-R

C

B-L

EnvelopeSingle sheets and cards

A

B-L, B-R

C

EPSON 4 × 6-inch Photo Paper 
(dotted lines indicate perforations)
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A: The minimum top margin is 0.12 inch (3.0 mm).

BL: The minimum left margin is 0.12 inch (3.0 mm).

BR: The minimum right margin is 0.54 inch (14.0 mm).

C: The minimum bottom margin is 0.12 inch (3.0 mm).

Note:
Always load paper into the sheet feeder short edge first except envelopes. Load envelopes long 
edge first.

Ink Cartridges

* The print capacity may vary depending on how often you use the print head cleaning function. Also, if you 
print large graphics and dense text with little white space, you use ink faster.

** The ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Caution:
To ensure good results, use genuine EPSON cartridges and do not refill them. Other 
products may cause damage to your printer not covered by EPSON’s warranty.

Do not use an ink cartridge after the expiration date on the package.

A

B-L B-R

C

EPSON Panoramic 
Photo Paper 

Specification Black ink cartridge (S020108) Color ink cartridge (S020089)

Color(s) Black Cyan, magenta, and yellow

Print capacity* 900 pages (A4 paper; 
text at Normal - 360 dpi) 
(ISO/IEC 10561 Letter Pattern)

300 pages (A4 paper; 
Normal - 360 dpi, 5% each color)

Cartridge life 2 years from production date and up to within 6 months after opening package at 77 °C 
(25 °F)

Storage 

temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 

temperature

–22 to 140 °C (–30 to 60 °F)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 

temperature**

–3.2 °F (16 °C) –0.4 °F (–18 °C)

Dimensions 1.09 (W) × 2.1 (D) × 1.5 (H) inches
27.8 (W) × 52.7 (D) × 38.5 (H) mm

1.7 (W) × 2.1(D) × 1.5 (H) inches
42.9 (W) × 52.7 (D) × 38.5 (H) mm
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Mechanical
Paper feed method Friction with auto sheet feeder, rear entry

Sheet feeder capacity Maximum 100 sheets of 17 lb (64 g/m2) paper

Dimensions Storage
Width: 18.7 inches (475 mm) 
Depth: 10.7 inches (274 mm) 
Height: 7.4 inches (177 mm)

Printing
Width: 18.7 inches (475 mm) 
Depth: 24.0 inches (610 mm)

27.2 inches (692 mm, when loading transparencies)
Height: 12.4 inches (315 mm)

7.95 inches (202 mm, when loading transparencies)

Weight 14.3 lb (6.5 kg) without the ink cartridges

Electrical

* Also designed for IT power systems with Phase to Phase voltage 
220–240V

Environmental
Temperature Operation 50 to 95 °F (10 to 35 °C)

Storage*  –4 to 140 °F (–20 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Humidity Operation 20 to 80% RH
Storage* 5 to 85% RH 

(without condensation)

* Stored in shipping container

Safety Approvals
Safety standards UL 1950 with D3, CSA 22.2 950 with D3

Specification 120V model 240V model*

Input voltage range 103.5V to 132V 198V to 264V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.4A 0.2A

Power consumption Approx. 18 W (ISO/IEC 10561 Letter Pattern)
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EMC FCC part 15 subpart B class B
CSA C108.8 class B

DOS Support
If driver support for the EPSON Stylus COLOR 850Ne is not 
available from your software manufacturer, you can use one of the 
other EPSON ESC/P 2 printer drivers. Choose the first printer 
available from the following two lists:

Black printing only ◗ LQ-870/1170
◗ LQ-570(+)/1070(+)
◗ SQ-870/1070
◗ LQ-850
◗ LQ-500

Color and black 
printing

◗ EPSON Stylus PRO
◗ EPSON Stylus COLOR 500
◗ EPSON Stylus COLOR II
◗ LQ-860
◗ LQ-2550

Control Panel Settings
You can change the following default settings from the printer’s 
control panel:

Setting Options

Print direction Auto, Bi-D, Uni-D

Font Courier, Roman, Sans Serif, Prestige, 
Script, Roman T, Sans Serif H, Draft

Pitch 10 cpi, 12 cpi, 15 cpi, 17.1 cpi, 20 cpi, 
Proportional

I/F mode Auto, Parallel, Serial, Option

Auto I/F wait time 10 seconds, 30 seconds

Software ESC/P 2, IBM X24E

Auto CR (IBM mode only) Off, On

AGM (IBM mode only) Off, On

Character table PC437, PC850, PC860, PC861, PC863, 
PC865, Abicomp, BRASCII, Roman 8, ISO 
Latin 1

International character set for 
italic table

Italic U.S.A., Italic France, Italic Germany, 
Italic U.K., Italic Denmark 1, Italic Sweden, 
Italic Italy, Italic Spain 1

Auto line feed Off, On
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Changing control 
panel settings

Follow these steps to change the settings listed above:

1. Make sure the printer is turned off and has paper loaded.

2. Hold down the 

 

X color cleaning button and press the 

 

Ppower 
button. The printer prints a summary of instructions for 
changing settings and choosing the language to use for additional 
instructions.

3. Press the 

 

X color cleaning button to print a list of current settings 
and additional instructions.

4. After you make the changes you want, turn the printer off to save 
the settings. The settings remain in effect until you change them 
again.

Control Codes 
ESC/P 2 control codes See the ESC/P® Reference Manual for more information about these 

commands.

General operation:
ESC @, ESC U, ESC EM

Paper feeding:
CR, FF, LF, ESC 0, ESC 2, ESC 3, ESC +

Page format:
ESC ( C, ESC C, ESC C 0, ESC Q, ESC l, ESC ( c, ESC N, ESC O

Print position motion:
ESC $, ESC \, ESC ( V, ESC ( v, ESC D, HT, ESC B, ESC J, VT

Font selection:
ESC k, ESC x, ESC X, ESC P, ESC M, ESC g, ESC p, ESC 4, ESC 5, 
ESC E, ESC F, ESC !

Font enhancement:
ESC W, DC 4, SO, DC2, SI, ESC w, ESC G, ESC H, ESC T, 
ESC S, ESC -, ESC ( -, ESC q

Spacing:
ESC Space, ESC c, ESC ( U

Character handling:
ESC t, ESC ( t, ESC R, ESC %, ESC &, ESC :, ESC 6, ESC 7, 
ESC ( ^ 

Bit image: 
ESC *

Network I/F mode Off, On

Loading position 8.5 mm, 3 mm, Others

Economy Off, On

Setting Options
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Graphics: 
ESC ( G, ESC ., ESC ( i, ESC ( e, ESC ( \, ESC ( s

Color:
ESC r, ESC ( r

Printing mode:
ESC ( K

IBM X24E emulation 
control codes

This printer emulates the IBM Proprinter with the following 
commands. For detailed information, see IBM’s X24E reference 
manual.

General operation:
NUL, DC3, ESC j, BEL, CAN, DC1, ESC Q, ESC [ K, ESC U

Paper feeding:
FF, LF, ESC 5, ESC A, ESC A (AGM*), ESC 0, ESC 1, ESC 2, 
ESC 3, ESC 3 (AGM*), CR

Page format:
ESC C, ESC X, ESC N, ESC O, ESC 4

Print position motion:
ESC d, ESC R, ESC D, HT, ESC B, VT, ESC J, ESC J (AGM*)

Font selection:
DC2, ESC P, ESC :, ESC E, ESC F, ESC I

Font enhancement:
DC4, SO, ESC SO, ESC W, ESC [ @, SI, ESC SI, ESC G, ESC H, 
ESC T, ESC S, ESC -, ESC _

Spacing:
BS, SP, ESC [ \

Character handling:
ESC 6, ESC 7, ESC [ T, ESC ^, ESC \

Bit image:
ESC K, ESC L, ESC Y, ESC Z, ESC [ g, ESC * (AGM*)

* Alternate Graphics Mode

Character Tables
All character tables except Italic are the same as the PC437 table for 
hex codes 00 through 7F. Additional characters are available for hex 
codes 80 through FF. You can select the following character tables 
through the control panel or software commands:

◗ PC 437 (U.S./Standard Europe)
◗ PC850 (Multilingual)
◗ PC860 (Portuguese)
◗ PC861 (Icelandic)
◗ PC863 (Canadian-French)
◗ PC865 (Nordic)
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◗ Abicomp
◗ BRASCII
◗ Roman 8
◗ ISO Latin 1
◗ Italic (no characters available for hex code 15)

International
character sets

You can select a number of international character sets with the 
control panel or the ESC R command. Other sets can only be selected 
with the ESC R command. You can select additional characters with 
the ESC ( ^ command.
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Glossary

10BaseT See twisted-pair cable.

address resolution
protocol (arp)

Network protocol that is part of the TCP/IP protocol suite. See 
also TCP/IP.

AppleTalk Macintosh networking protocol.

banding The horizontal lines that sometimes appear in a printed image. 
See also MicroWeave.

buffer The portion of the printer’s memory used to store data before 
printing it.

character table A collection of letters, numbers, and symbols that provides you 
with the characters used in a particular language.

characters per inch (cpi) A measure of the size of text characters, sometimes referred to as 
pitch.

CMYK Cyan (blue-green), magenta, yellow, and black. These colored 
inks are used to create printed colors.

ColorSync Macintosh software that is designed to help you get WYSIWIG 
(what you see is what you get) output. This software prints 
colors as you see them on your screen.

configuration The setup of a client, server, or network. 

configure To change the setup of a client, server, or network.

default A value or setting that takes effect when the equipment is 
turned on, reset, or initialized.
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dithering A halftoning method in which dots are arranged in an orderly 
pattern. Dithering works best for printing images with solid 
colors, such as charts and graphs. See also halftoning.

dpi Dots per inch. The dpi measures the resolution (print quality). 
See also resolution.

driver A software program that sends instructions to a computer 
peripheral to tell it what to do. For example, your printer driver 
accepts print data from your word processing application and 
sends instructions to the printer on how to print this data.

Error Diffusion This halftoning setting smooths out edges by randomly placing 
dots of varying colors. 

ESC/P Abbreviation for Epson Standard Code for Printers. This 
system of commands gives you control of your printer from 
your computer. It is standard for all EPSON printers and 
supported by most application programs for personal 
computers.

ESC/P 2 The enhanced version of the ESC/P printer command 
language. Commands in this language produce laser-like 
features, such as scalable fonts and enhanced graphics printing.

Ethernet Local area network technology that allows multiple 
transmissions to occur simultaneously.

EtherTalk Macintosh protocol for connecting to an Ethernet network.

file server A computer that holds files that other clients can access. 

font A style of print designated by a name.

gateway A system connected to more than one network that receives and 
delivers information from one network to the other(s).

grayscale Shades of gray ranging from black to white. Grayscale is used to 
represent colors when you print with black ink only.
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halftoning A method of using dot patterns to represent an image. 
Halftoning makes it possible to produce varying shades of gray 
using only black dots, or a nearly infinite array of colors using 
only a few colors of dots.

hub A physical network device that receives, routes, and sends 
information from computers or peripherals to the others on the 
network.

initialization Returns the printer to its defaults. This happens every time you 
turn on or reset the printer.

ink jet A method of printing in which each letter or symbol is formed 
by precisely spraying ink onto paper.

ips Inches per second. This scale is used to measure the print head 
speed.

IPX/SPX Network protocol used mostly by Novell NetWare.

LPR Printing protocol.

media Materials upon which data is printed, such as envelopes, plain 
paper, special paper, and transparency film.

MicroWeave Printing technology that produces images in fine increments to 
reduce the possibility of banding. See also banding.

node address The hardware address of any client, server, or peripheral on a 
network.

packet A unit of data that can be sent over a network.

peripheral A device such as a printer or a scanner that works with a 
computer.

ping A command that requests a response from a remote computer 
over a network.

print queue Print jobs that are sent to the printer while it is busy are stored 
in a waiting line, or print queue, until they can be printed.
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print server A print server holds all the print information and performs all 
printing functions. The card can act as a print server when it is 
in print server mode, selectable through Novell NetWare.

printable area The area of a page on which the printer can print. It is smaller 
than the physical size of the page because of margins.

printer driver See driver.

proportional printing Printing in which the width of the character varies from 
character to character. For example, a capital W receives much 
more space than a lowercase i. 

Also, a setting in the EPSON Printer Software that allows you 
to make the printed size of a document different from its actual 
size.

protocol A set of rules and formats that computers use to communicate 
to one another and to peripherals over networks.

remote printer A printer that is connected directly to the network and chooses 
a specified print server when it is turned on. 

reset To return a printer to its defaults either by sending a command, 
an INIT signal, or by turning the printer off and then back on.

resolution The number of dots per inch used to represent an image. The 
higher the resolution or print quality, the more detailed and 
realistic the image.

router A device that connects multiple segments of a network and 
determines when and where to send information from each 
segment to the others.

scalable fonts Fonts that can be enlarged or reduced. Non-scalable fonts 
(bitmap fonts) can’t change in size.

screen pattern This feature prints shaded areas as they appear on screen, 
instead of printing them as halftones.

spool manager A software program that converts print data into codes that 
your printer understands. 

bunnyUG.book  Page 4  Wednesday, November 4, 1998  9:22 AM



Glossary

G-5

status monitor A software program that allows you to check the printer’s status, 
such as the amount of ink remaining before printing.

subnet mask A number used to separate different parts of a network, or 
subnets. The subnet mask can divide an IP network into smaller 
parts.

TCP/IP Transmission Control Protocol/Internet Protocol. A protocol 
suite made up of two parts (TCP and IP) that organizes and 
delivers data across a network.

twisted pair cable Also called 10BaseT. This cable is used in Ethernet networks. 
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Index

A Accessories, A-1 to A-2
Advanced mode, selecting, 

3-2 to 3-4
Advanced settings

color, 3-7 to 3-10
custom, 3-4 to 3-33
predefined, 3-2 to 3-4
saving custom, 3-34

Aligning print heads, 5-8 to 5-9, 
6-5

Automatic mode, 1-2, 1-8

B Background printing, Macintosh, 
4-15 to 4-17

Banding, 6-5
Blank pages, 6-17
Blurry printouts, 6-7
Brightness setting, 3-8

C Cards, see Photo Quality media, 
Ink Jet Cards

Character sets, international, B-2
Character tables, B-2, B-9
Characters, garbled, 6-15
Cleaning print heads, 5-6 to 5-8

using Head Cleaning utility, 
5-6 to 5-7

Cleaning printer, 5-10
Cleaning sheets, 2-3
Color Adjustment modes, 3-8
Color problems, 6-6
ColorSync, using, 3-3, 3-9 to 3-10
CompuServe, 5
Configuration button, 4-19
Contrast setting, 3-8
Control codes, B-2, B-8 to B-9
Control panel default settings, B-7

Control panel, using, 1-10, 
5-7 to 5-9, 6-3

Custom settings
changing, 3-34
color, 3-7 to 3-33
deleting, 3-34
list, 3-2
print quality, 3-4 to 3-6
saving, 3-33 to 3-34
special effects, 3-4 to 3-6

Cyan setting, 3-8

D Default control panel settings, B-7
Default printer options, setting, 

1-4
Deleting print job, 4-14
Despooler, 1-5, 6-12
Dithering, 3-6
DOS support, B-7
Driver, 1-1

E Economy setting, 3-3
Electrical specifications, B-6
Energy Star, 6
Envelopes

loading, 2-5
specifications, B-4 to B-5

Environmental specifications, B-6
EPSON

Accessories, A-1 to A-2
Customer Care Centers, 5
Electronic support services, 

5 to 6
help, 5 to 6
media, 2-1 to 2-3
World Wide Web site, 5

EPSON Spool Manager, see Spool 
Manager
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Error Diffusion setting, 3-6
Error notification, 4-20
ESC/P 2 control codes, B-2, B-8

F Faint printouts, 6-6
Film, see Photo Quality media, 

glossy media
Finest Detail setting, 3-6
Fit to Page setting, 3-27 to 3-29
Flip Horizontal setting, 2-8, 3-6, 

6-16
Fonts, B-2, B-7
Forms, loading, 2-3
FTP Site, EPSON, 5

G Garbled characters, 6-15
Glossy media, 2-3 to 2-4, 

B-3 to B-4

H Halftoning setting, 3-6
Head Cleaning utility, 5-6 to 5-7
Help

EPSON, 5 to 6
software, 1-2, 6-2

Hex dump mode, 6-4
High Speed setting, 3-6
Horizontal banding, 6-5

I IBM X24E emulation control 
codes, B-2, B-7 to B-9

ICM (Image Color Matching) 
setting, 3-3, 3-9

Ink
cartridge ordering, A-1
cartridge specifications, B-5
monitoring level, 1-10
replacing cartridges, 5-1 to 5-5
replacing outdated cartridge, 

5-5
setting, 1-8
smears, 2-5
specifications, B-5
supply, 4-18

Ink Jet Cards, see Photo Quality 
Ink Jet Cards

Ink Jet Cards, see Photo Quality 
media, Ink Jet Cards

Ink Jet Paper
choosing, 1-8, 2-1 to 2-2, 

A-1 to A-2
loading, 2-3
specifications, B-3 to B-5

Ink Jet Transparencies, see 
Transparencies

Interface (I/F) mode setting, B-7
International character sets, B-2, 

B-9
Internet, 5
Iron-On Transfer Papers, 

2-1 to 2-2, 2-8, B-3 to B-4

J Jammed paper, 1-10, 6-14

L Landscape setting, 3-17
Layout button, 1-9
Letterhead, see Paper
Lights, using, 1-10, 6-1 to 6-3
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M Macintosh
ColorSync, 3-9 to 3-10
configuration options, 

4-19 to 4-20
increasing memory allocation, 

4-16
managing print jobs, 

4-16 to 4-20
Monitor3, 4-15 to 4-17
printing from, 1-7 to 1-9
problems printing, 6-11
Status Monitor, 1-9, 4-17
uninstalling software, 6-18

Magenta setting, 3-8
Main tab, 1-2
Maintaining printer, 5-1 to 5-10
Manual, how to use, 3 to 4
Margin

problems, 6-16
with multiple sheets, 2-4

Mechanical specifications, B-6
Media Type setting, 1-3, 1-8, 

2-1 to 2-2
Memory allocation, increasing on 

Macintosh, 4-16
MicroWeave setting, 3-6
Monitor3, 4-15 to 4-17
Monitoring

ink level, 1-10
More Settings dialog box, 

3-4 to 3-10
Multiple print layouts, 

3-23 to 3-24, 3-29 to 3-30

N Nozzle Check, 5-8

P Packing printer, 5-10
Page frames, 3-23 to 3-24, 

3-29 to 3-30
Page Order options, 3-24
Page Setup dialog box, 1-7
Panoramic Photo Paper, see Photo 

Paper

Paper
EPSON, 2-1 to 2-8, A-1 to A-2
handling problems, 

6-13 to 6-15
loading, 2-3 to 2-7
ordering, A-1
plain, 1-3
specifications, B-3 to B-5

Paper jams, 1-10, 6-14
Paper support, 2-4
Paper tab, 1-3
Paper thickness lever, 2-5, 6-7
Photo Paper

choosing, 1-8, 2-2, A-2
loading, 2-6 to 2-7
specifications, B-3 to B-5

Photo Quality glossy media
choosing, 1-8

Photo Quality Ink Jet Cards, A-2
Photo Quality media

glossy media
choosing, 1-8, 2-2, A-1 to A-2
loading, 2-4
specifications, B-3 to B-5

Ink Jet Cards, 2-2, 2-7, 
B-3 to B-4

Ink Jet Paper
choosing, 1-8, 2-2, A-1
specifications, B-3 to B-4

Self Adhesive Sheets, 2-2, 2-8, 
A-2, B-3 to B-4

Photo setting, 3-3
Photo Stickers, 2-2, A-2, B-3
PhotoEnhance setting, 3-3, 3-9
Plain paper, 1-3, B-3 to B-4
Portrait setting, 3-17
Preprinted forms, loading, 2-3
Print Head Alignment utility, 

5-8 to 5-9, 6-5
Print heads, cleaning, see Cleaning 

print heads
Print jobs

deleting, 4-14
managing in Windows, 

4-1 to 4-15
managing on Macintosh, 

4-15 to 4-20
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Print layouts, multiple, 
3-23 to 3-24, 3-29 to 3-30

Print quality
customizing, 3-4 to 3-6
problems, 6-4 to 6-7

Print queues, 4-13 to 4-15
Printable area

specifications, B-4 to B-5
Printer driver, 1-1
Printer software

uninstalling, 6-17 to 6-18
Printing speed, B-1
Problems

diagnosing, 6-1 to 6-4
paper handling, 6-13 to 6-15
print quality, 6-4 to 6-7
printing, 6-8 to 6-13
slow printing, 6-12
solving, 6-1 to 6-18
Status Monitor 2, 6-12
unexpected printout results, 

6-15 to 6-17
uninstalling software, 

6-17 to 6-18
Progress Meter

dialog box, 1-5
Proportional Printing option, 3-12, 

3-20 to 3-23

Q Quality/Speed slider, 1-9

R ReadMe files, 6-2
Rendering Intent setting, 3-10
Replacing ink cartridges, 5-1 to 5-5
Resolution, 1, 3-5

see also Print quality
Rotate by 180° setting, 3-17

S Safety
approvals, B-6
instructions, 7 to 8

Saturation setting, 3-8
Self Adhesive Sheets, see Photo 

Quality media, Self Adhesive 
Sheets

Self test, 6-3
Service, 5 to 6
Settings, default, 1-4
Settings, printer software

advanced, see Advanced settings
checking, 1-2 to 1-4, 1-7 to 1-9
reusing on Macintosh, 1-7

Slow printing, 6-12
Smears, 2-5
Special effects, 3-4 to 3-6
Specifications

character tables, B-9
control codes, B-8 to B-9
control panel settings, B-7
DOS support, B-7
electrical, B-6
environmental, B-6
ink cartridges, B-5
mechanical, B-6
paper, B-3 to B-5
printing, B-1 to B-2
safety approvals, B-6

Speed, printing, B-1
Spool directory, changing default, 

4-14 to 4-15
Spool folders, 4-10, 4-19 to 4-20
Spool Manager

deleting print job, 4-14
problems, 6-9, 6-11, 6-15
using, 4-12, 4-13 to 4-15

Stalled print jobs, deleting, 4-12
Status Monitor

Macintosh, 1-9, 4-17
Status Monitor 2

problems, 6-12
Windows, 1-5, 6-17

Support, 5 to 6
System requirements, 1 to 2
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T Technical specifications, 
B-1 to B-10

Testing printer, 6-3
Text/Graph setting, 3-3
Thickness lever, 2-5, 6-7
Transparencies

choosing, 1-3, 1-8, 2-2, A-2
loading, 2-4
specifications, B-3 to B-4

Transporting printer, 5-10
Troubleshooting, 6-1 to 6-18

U Utility
button, 1-9, 5-6 to 5-7, 5-9
tab, 5-6 to 5-7, 5-9

W Windows
checking printer status, 

1-5 to 1-6
managing print jobs, 

4-1 to 4-15
printing from, 1-1 to 1-6
Spool Manager, 4-13 to 4-15

Windows 95
problems, 6-11 to 6-12

World Wide Web, 5

Y Yellow setting, 3-8
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